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Preface
For details, see the following topics:

• About this documentation

• Notation conventions

• Aurea global support

About this documentation
This guide is par t of the documentation set for Aurea CRM.

Notation conventions
This document uses the following notation conventions:

MeaningConvention

Fixed-width font indicates code, path names, file names, envi-
ronment variable names, parameter names, command names,
machine names, URLs.

Fixed-width

Bold Fixed-width  font is used to indicate user input or to
emphasize cer tain lines of code.

Bold Fixed-
width

Italic Fixed-width font indicates a placeholder for which you
must supply a value.

Italic Fixed-width

Bold sans serif typeface indicates the names of graphic user
interface elements such as dialog boxes, buttons, and fields.

Bold Sans serif

In text, italic serif typeface indicates the first use of an impor-
tant term. The term is defined in the glossary.

Italic serif

Underlined text in command lines and parameter descriptions
indicate that you only have to enter the underlined part of the
command or parameter name. For example, if you use
the-LOGFILE parameter in a command, you only need to enter
-LOGF.

Underlined

Brackets enclose optional arguments.[ ]

Braces enclose two or more items. You can specify only one
of the enclosed items. Vertical bars represent OR separators.
For example, you can specify a or b or c.

{ a | b | c }
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MeaningConvention

Three consecutive periods indicate that you can repeat the
immediately previous item. In code examples, they can be
horizontal or ver tical to indicate omissions.

...

An angle bracket between two menu items indicates that you
should choose an item from a menu. For example, the notation
File >  > Exit means: "Open the File menu and choose Exit."

Menu > Choice

Links to related information in other chapters or documents are
indicated using the >> symbol.

>>

Aurea global support
If you encounter a problem while using an Aurea product or require assistance with
downloading the software or upgrading a product release, please open a ticket on
Aurea Support Central. Preferably, search the ar ticles on the Aurea Knowledge
Base for solutions to your issues before opening a ticket.

Information about the support organization is available on Support Central. The
product documentation is available athttps://help.aurea.com/crm/#.

For information about purchasing an upgrade or professional services, contact your
account executive. If you do not know who your account executive is, or for other
queries, contact us through our website.
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2
Introduction
CRM.cockpit installation is used to manage Aurea.CRM and generate documentation
in RTF format.

CRM.cockpit can be used for the following:

• Document changes you have made to the standard configuration and output
documentation to file, see Documentation on page 100 .You can enter descriptions
for items referenced by your package (see below), and these descriptions are
included in the documentation generated by CRM.cockpit.

• Deploy configurations on target systems. Once imported on the target system,
all configuration items in the package are available in the target database,
see Importing and Exporting Packages on page 60.

• Update existing versions of the same package on a target system. Any changes
to items in the package should be made on the source (development) system,
and there are cer tain restrictions that apply to packages imported into databases
that already contain data, see Importing Packages on page 65 .

• Develop demo versions by including processes and data that can then be imported
into the demonstration database in one step.

Packages

CRM.cockpit allows you to create and maintain packages for Aurea.CRM, see
Packages on page 22 . Use packages to collect and manage changes you have
made to the default configuration of Aurea.CRM and distribute them to other systems.
Each package can include references to any number of processes, which in turn
contain references to various configuration items, such as the data model (info
areas, fields, catalogs), CRM.designer configurations, formats and files (e.g.
JavaScript, XSLT), see Processes on page 36 and Configuration Items on page 47
.

Packages can be used to manage both Aurea.CRM win and designer configurations.

Note:  designer databases are used by Aurea.CRM web, CRM.pad and CRM.mobile.

This allows you to create sector-specific packages that can easily be deployed with
minimum configuration overheads. Instead of reconfiguring similar configurations
from scratch, you can use a package as the basis for sector-specific installations,
which only needs to be extended with customer-specific processes.
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Configuration items are not configured within CRM.cockpit; you need to define these
items within Aurea.CRM itself. CRM.cockpit is used to determine which of these
items are included to form a package by adding items from the Aurea.CRM win and
CRM.designer databases. The package itself is also saved in the Aurea.CRM win
database. You can synchronize the package with the database, in order to gain an
overview of the changes made to items in the database since the last synchronization,
see Synchronizing Packages on page 57 .

Transport Management

The package and items within the package can be exported as a .zip file and im-
ported on your target installation, see Importing and Exporting Packages on page
60 . Packages should be developed on a development system, from which the desired
processes are exported. The resulting .zip file is then imported into your production
environment.

Note:  CRM.cockpit is used to both import and export packages. CRM.cockpit
therefore needs to be installed on both the source and target systems.

You can update earlier versions of the same package on the target system, subject
to some restrictions, see Updating Packages on page 72.

Creating Documentation

In addition to managing Aurea.CRM configurations, CRM.cockpit also allows you to
document the various items included in a package, as well as the package itself,
see Documentation on page 100 . You can generate documentation in RTF format,
which reflects the current state of the package. It thus becomes much easier to
maintain configuration items and for other users to quickly determine the functional-
ity of items and processes in a package.

For an overview of the terms and concepts in CRM.cockpit, see Glossary on page
19 .

Requirements
Requirements to use CRM.cockpit.

• A connection to the Aurea.CRM win database is required, as CRM.cockpit saves
packages in this database.

• The Special (SU) and WWW users need to be present in the Aurea.CRM win
database in order to run CRM.cockpit.

• The Special (SU) and WWW users' passwords need to be entered using up-
date.Users.exe in the \bin directory. For more information, refer to the install
guide.

• The Special (SU) and WWW users require access to the cockpit module (in the
Rights module).

• The WWW user requires read access to the Station (AS) and Language/Station
(01) info areas.
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Documentation PDFs
Download the pdf help for CRM Cockpit user here.

DescriptionDocument

A user manual for the CRM Cockpit.Cockpit user manua

Typographical Conventions
Learn how to use this manual.

The following formatting is used in this manual:

• Gray and bold: Menu commands, menu names, titles of dialog boxes, check boxes,
radio buttons, info area names, names of fields and buttons are written like this.

• Menu commands: "Select New > New Person from the context menu" means that
you should first select New and then New Person from the record's context menu.

• Bold: Particularly important information is written in bold.

• Keyboard shortcuts: Simultaneous key strikes are identified by placing a plus sign
between the key designations, e.g. Alt+D.

• Notes and tips:

Note:  Notes and tips are displayed like this in the text.

• Related information: Links to related information in other topics or documents are
indicated using the >> symbol.

CRM.cockpit and Access Rights
Learn how to configure access rights for CRM.cockpit.

Any Aurea.CRM win user can be given access to CRM.cockpit. Any user can export
and configure packages. However, only the SU can import packages on the target
system.
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Access to CRM.cockpit is configured along with access to all Aurea.CRM win mod-
ules:

1. Open the Rights module.

2. Switch to the Rep info area, switch to the desired user and select Configure
Login from the context menu.

3. Enable or disable the cockpit check box under Module Access Rights as
appropriate.

For more information on access rights, see Rights in the Rights Module topic of the
CRM.core Administrator Guide.

Starting CRM.cockpit
Learn how to star t CRM.cockpit.

To star t CRM.cockpit:

1. Run the application. You can also use the command line to import or export
packages, see Command Line on page 74 .

2. Enter your user name and password and log in.

3. The last package that was open is loaded automatically. If no package exists,
and you are logged in as SU on the main office, you are asked if you wish to
import a .zip file or star t with an empty package.

4. CRM.cockpit is loaded and the Processes page is displayed, seeProcesses on
page 36 .

Note:  CRM.cockpit requires the SU and WWW users to be present in the database.
Only one user can log on to CRM.cockpit at a time. CRM.cockpit sessions timeout
according to the value entered in the User Tracking Frequency Web field in the
Station Configuration info area (Rights module). When logged in as SU, select
Extras > Active Processes from the menu in the Aurea.CRM win main module to
view the user currently logged on to CRM.cockpit, and terminate a session using
Repair if necessary.

Working in other Languages
Learn how to change languages in CRM.cockpit.

When logging on to CRM.cockpit, you can select the language used to display the
names of items in the CRM database. You can choose any of the languages assigned
to the current station.

Note: The user interface is still displayed in English.
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To change the language in which items are displayed:

1. Run the application.

2. Click on Expand/Reduce.

The login window is expanded and the Language drop-down list is displayed.

3. Select the desired language from the list.

4. Log in to the application.

Note: Your language settings are remembered and restored the next time
CRM.cockpit is star ted. The current language is displayed in the About box (select
Help > About CRM.cockpit from the menu).

5. Click on Check Unit Availability to update names and catalog entries to the new
language.

Note: The Language drop-down list is only available if at least two languages are
assigned to the current station. If no languages are defined for the station, English
is used by default. If the previously selected language is no longer available, English
is also used by default.You can also star t CRM.cockpit in a different language with
the following command line parameter:-l <language ID>For a list of language IDs,
>> Language IDs in the Appendix of the CRM.core Administrator Guide.

User Interface
Learn about the CRM.cockpit user interface.

The CRM.cockpit user interface is similar to the Aurea.CRM win user interface.
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1. The title bar displays the name of your package and your current database
connections in brackets.

2. The toolbar at the top of the screen contains buttons used to save and print,
navigate between screens and access the online help.

3. The breadcrumb trail provides you with an overview of your current location
within the package. Click on a hyperlink in the breadcrumb trail to switch directly
to that location.

4. The icon bar on the left of the screen allows you to access all the areas used to
define, view and import/export your package, see Icon Bar on page 12 . The
entries in the icon bar are also accessible from the View menu.

5. The main frame is where most of your work takes place. Items in the package
are displayed and edited in the main frame.

Icon Bar
Learn how to use the icon bar to access various areas in the CRM.cockpit.

The icon bar provides links to the areas in CRM.cockpit.

Package

Description: Displays the package's description page, see Description on page 24
.

History: Displays the package's history, see History on page 25 .
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Imports/Exports: Displays a list of imports and exports carried out for the current
package, see Import/Export History on page 82.

Items

Processes: Displays a list of the processes in your package, see Processes on
page 36 . Use this option to add items to processes and view the items already
added to processes.

Content: Displays the contents of the package by item type, see Content on page
27 . Use this option to view the elements in your package by type.

Tree View: Displays the hierarchical structure of the package, including all processes
and items in tree form, see Tree View on page 28 . Use this option to view the ele-
ments and relationships between items in your package.

Fields: Displays information on a specific field's references, see Fields on page 30
.

General

Data Model: Click on Data Model to browse the data model in your Aurea.CRM
database, see Data Model on page 28 .

All Imports/Exports: Displays a list of imports and exports for all packages,
see Import/Export History on page 82.

Miscellaneous
Additional information and functions in Aurea CRM.cockpit.

In the below topics you can find useful information for using CRM.cockpit.

CRM.cockpit Settings
Learn how to manually configure the databases accessed by CRM.cockpit.

You can manually configure the databases accessed by CRM.cockpit if necessary.
By default, the database settings are configured automatically during the setup
process.

Accessing the Aurea.CRM win Database

Access to the Aurea.CRM win database is configured in the same manner as for
Aurea.CRM win. The easiest way of configuring CRM.cockpit to access your Au-
rea.CRM win database is to copy the contents of the \system\sys directory from
your Aurea.CRM win installation to the \system\sys directory of your CRM.cockpit
installation.

Alternatively, you can edit the mmdb.ini file located in the \system\sys directory.
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Accessing the designer Database

Access to the CRM.designer database is configured in the Settings.xml file located
in the \system\settings directory of your CRM.cockpit installation:

1. Open the file (e.g. in Notepad).

2. Search for designerDsn.

The designerDsn string contains the following:

• Provider: The database type.

• Data Source: Enter your ODBC data source here.

• Initial Catalog: Enter the name of the database here.

• UID: Enter the user name used to access the database here.

• PWD: Enter the password used to access the database here.

Note: You need to configure database access on both the source and target
systems.

Configuring the Page Size for Items Requiring Synchronization

When synchronizing items, you can determine the number of items displayed on a
page in the list of items requiring synchronization. Enter the desired value in the
<value> element in the <update.cockpit.PlugIns.Synchronize.Properties.Settings>
element in the update.cockpit.exe.config file located in the installation directory:

<update.cockpit.PlugIns.Synchronize.Properties.Settings>

<setting name="SynchBrowserPageSize" serializeAs="String">

<value> 40 </value>

</setting>

</update.cockpit.PlugIns.Synchronize.Properties.Settings>

Possible values: 40-100. The default value is 40.

Configuring the Page Size for Records

You can determine the number of records displayed in the list when adding records
to a package in the Settings.xml file. Enter the number of records to display in the
list in the BrowserPageSize element. The default value is 1000.

Default Import and Export Folders

You can define a default folder for import and export files in the Settings.xml file
(ExportFolder/ImportFolder). If you define a default folder, this path is opened by
default when selecting File > Export Package as .zip File/Import Package from
.zip File from the menu). If you do not define a default folder, the last folder used
is opened instead.
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Package IDs

You can define an optional package ID in the Settings.xml file (CustomerInstanceID
element) on both source and target stations. If a package is exported on a station
where a package ID is defined, the same ID must be defined in the Settings.xml
file on the target station, otherwise the package cannot be imported. If no ID was
assigned to the package on the source station, the package can be imported on any
station (even if an ID is defined in the Settings.xml file on the target station).

Keyboard Shortcuts
Learn about the keyboard shortcuts.

The following keyboard shortcuts are used in CRM.cockpit:

DescriptionShortcut

Opens the online helpF1

BackAlt+Shift+Left

ForwardAlt+Shift+Right

Next interface elementTab

Previous interface elementShift+Tab

ConfirmEnter

New packageAlt+Shift+N

Open packageAlt+Shift+O

Save packageAlt+Shift+S

Save package asAlt+Shift+A

Revert to last saved versionAlt+Shift+R

Export package as .zipAlt+Shift+E

Import package from .zipAlt+Shift+I

Create DocumentationAlt+Shift+C
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DescriptionShortcut

ExitAlt+Shift+X

Data model explorerCtrl+Alt+D

View XML sourceCtrl+2

Check unit availabilityAlt+F5

Refresh Data ModelAlt+F6

Print main frameCtrl+P

Print screenAlt+Shift+P

Define Document StructureAlt+Shift+U

FAQ
Frequesntly asked Questions for CRM.cockpit.

What information is included in a package?

Packages are a container for configuration items you have defined in the course of
customizing Aurea.CRM win, Aurea.CRM web etc.

On the development machine, a package is stored in the Aurea.CRM win database.
The package in the database includes references to the configuration items within
the package, as well as the description, history, links and descriptive documents.
As such, configuration items themselves are stored within the corresponding areas
in Aurea.CRM.

Configuration items are extensions to the standard application as provided by update,
such as formats, catalogs, configuration files (e.g. JavaScripts for Aurea.CRM web),
designer units and the data model. You can also add records to a package.

When the package is exported, the .zip file generated by CRM.cockpit includes the
actual items, which are copied from the Aurea.CRM database on the target machine,
as well as any data entered in CRM.cockpit (e.g. descriptions, hyperlinks, descriptive
documents). These items can then be imported on the target machine.

I have added some custom info areas to Aurea.CRM. How can I apply my
changes to the data model to another Aurea.CRM installation?

The data model is automatically included in the package if you add an item from
the customized data model. Add one of the info areas you have created to a process
in the package. Export the process and import the .zip file on the target machine.
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Can I import a package into an existing installation (i.e. not a new one with a
blank database)?

You can upgrade earlier versions of the same package by importing a newer version
of the package from a .zip file.

You can import a package into a database that already contains data, providing the
source and target stations have different numbers. If the station numbers are iden-
tical, existing records with the same key are overwritten in the target database.

How does cockpit and transport management relate to other mechanisms such
as CRM.bulkloader, initial stock downloads, communication etc.?

The transport mechanism provided in CRM.cockpit has been primarily designed for
transferring extensions to the default configuration from one system to another.
Formats, changes to the data model, designer configurations and files in the file
system can be transferred.

Whilst it is also possible to transfer records using CRM.cockpit, this is not
CRM.cockpit's main task, and CRM.cockpit has not been designed with the mass
transfer of records in mind.

Other transport mechanisms cater to other tasks, and are better suited to transfer-
ring and synchronizing data between systems.

Can I perform all customizing work from within cockpit?

Customizing is performed from within Aurea.CRM. You cannot customize items from
within CRM.cockpit.

What do I have to do when a new version of Aurea.CRM is released? Can I still
use my packages?

Yes, you can use your existing packages. However, CRM.cockpit is only able to
import .zip files that were exported from the same version of CRM.cockpit.

To migrate a package (available as a .zip file or in the database) to a .zip file corre-
sponding to the latest version:

1. Import the .zip file into the database, if necessary.

2. Upgrade Aurea.CRM win and Aurea.CRM web to the current version and upgrade
the designer database.

3. Upgrade CRM.cockpit.

4. Load the package in cockpit.

5. Export the package from cockpit as a zip file.

This ensures that the owner of the package migrates the package to the latest version
of Aurea.CRM and verifies that the package works correctly, before implementing
the package on a customer's system. It is therefore up to the owner of a package
to migrate the package once a new version of Aurea.CRM is released.
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Troubleshooting
Troubleshooting tips for CRM.cockpit.

Error -66 occurs when logging in

Error (-66) occurs when a user is already logged on to CRM.cockpit; only one user
can log on at a time.

If you receive this error message, verify whether another user is logged on to
CRM.cockpit:

1. Log on to the Aurea.CRM win main module as SU.

2. Select Extras > Active Processes from the menu.

A list of the active processes and users is displayed.

3. If a CRM.cockpit session was not terminated correctly, the corresponding process
may not have been closed. Click on Repair to remove inactive processes.

Error -79 occurs when importing the data model

This can have the following causes:

• The data model in the package is the same as the data model in the database,
for example if your data model has not changed since the last import, or if you
try to import the same package twice

• The source and target station numbers are the same. The station numbers must
be different.

Names and Items are displayed in a mix of languages

This usually occurs if items have been added to a package by users logging on in
different languages. Not all items are refreshed when a package is loaded after
logging in. In this case, those items added by a user using German are displayed
in German; those items added by a user using English are displayed in English etc.

Click on Check Unit Availability to refresh all items in the package.

A warning is displayed when importing a package that the package languages
are different

A message is displayed if the package is exported using a different login language
than it is imported with:

As cer tain fixed catalog values are matched up by text, importing and exporting with
different languages can cause problems with fixed catalogs.

Click Cancel and log on again in the same language as the package was exported
with.

I removed the "Data Model" item on import

The Data Model item is a format containing the definition of the data model. If the
Data Model item is not imported, all its dependent items are also not imported. Most
items in a package are generally dependent on this format.
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Recently imported data cannot be loaded/changes made to items are not
included in the export

Disable the record cache in performanceSettings.xml in the \system\sys directory.
For more details, >> Record Cache in the CRM.core Administrator Guide.

The import process failed to complete and new imports are no longer possible

Check whether the process tracking record for the import is set to completed. If the
process is still open, use the repair function in Aurea.CRM win or Aurea.CRM web
to unlock the process.

Glossary
Glossary of terms.

The following terms and concepts are important when working with CRM.cockpit:

Base Package: Base packages are developed on station 10,000 and can be imported
into any ver tical version. Only items (info areas, catalogs etc.) common to all ver ticals
can be added to a base package. Certain info areas differ slightly between ver ticals,
e.g. the info area codes differ or the field numbers are not identical. Base field
numbers and info area codes are available for these items in Aurea.CRM, and these
base IDs can be used to reference these items across ver ticals.

Configuration item: Configuration items are added to processes as references,
and form the bottom level in the package hierarchy. Configuration items can be
formats, files, web designer configurations, records, info areas and catalogs. Each
item can only be referenced by a process once.

Data model: The data model refers to the structure of the database tables used by
Aurea.CRM. Catalogs and info areas are both parts of the data model. The core
section of the data model encompasses the data model as provided by update; it
includes all the default info areas and catalogs. Users can expand upon the default
data model provided by update, e.g. by adding fur ther info areas.

All these settings are stored in a single format.

Databases: CRM.cockpit can read configuration items from both Aurea.CRM win
and designer databases. Whilst developing your package, the package is stored in
the Aurea.CRM win database on the development system. You therefore require
access to a Aurea.CRM win database in order to work with CRM.cockpit. If you are
not working with a designer database, no designer units are displayed in
CRM.cockpit.

Development system: Packages should be defined on a development system, before
being exported for use in a production environment. CRM.cockpit needs to access
the databases used by the development system.
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Documentation: CRM.cockpit can be used to document your configuration items.
Descriptions can be entered for items that are referenced in a package, and a his-
tory is available for the entire package and all its items. You can generate documen-
tation using CRM.cockpit that includes an overview of the configuration items and
processes in your package. Documentation can be generated in RTF format.

Export: Once a package has been defined, it needs to be exported to a .zip file on
the development system. You can select the processes that are exported.

Group: Groups allow you to define conditions applied to records in an info area,
and to include the records that meet these conditions when exporting the package.
Sub-groups can be added to groups, allowing you to apply additional conditions to
records in child info areas, and to export these child records as well.

Import: Once a package has been exported, it needs to be imported on the produc-
tion system. During the import process, elements in the package are written to the
database, and files (e.g. JavaScript, XSLT files) are copied to the appropriate direc-
tories. There are two types of import: importing a package into an empty database,
and upgrading an existing package. If you upgrade a package, and different versions
of items are present in both the package and the target database, you may need to
match up these items and determine which of the items to retain.

Match-up: When importing a package into a database, items can be present in both
the package and the target database. If the item has been changed in both the
package and in the target database since the last import, you need to determine
which of the items to store in the database.

Process: A process is an element below the root package element that encapsulates
various configuration items (e.g. formats). Any number of process can be added to
a package, and any number of items can be added to a process. However each item
can only be added to a process once. When exporting your package, you can select
which processes to export.

Production system: The production system is also referred to as the target system.
After exporting a package on the development system, the resulting .zip file need
to be imported on the production system.

Synchronization: Configuration items are added to processes as references. In
other words, configuration items are stored in the databases, and are only included
in the package when the package is exported. Configuration items are edited and
created from within Aurea.CRM, not in CRM.cockpit. Synchronize the package with
the database in order to display and manage those configuration items in the
database that have been added, deleted or edited since the last synchronization
process.

Package: A package is the root element that encapsulates your processes. Processes
in turn can contain various types of configuration items, such as formats, files or
data model elements. Packages are stored in the Aurea.CRM database and can be
exported.
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Upgrade: Packages deployed on a production system can be upgraded by importing
an updated version of the same version.

Error Codes
Learn about the common error codes.

The most common error codes are listed below:

• -103: The record or format references a catalog entry that is not present. This
generally occurs if importing catalogs and catalog maintenance items resulted in
an error.

• -105: The record of format references a rep that is not present. This generally
occurs if the source database contains formats that reference reps that are no
longer in the database.

• -1002: Occurs if a record with the same key already exists in the target database
and the record in the target database was not imported as part of a CRM.cockpit
package. If this error occurs for catalog entries, this may be caused by not
including the catalog maintenance items (in which case the catalogs are imported
anew).

• -1013: The record is incomplete or the data is erroneous. This may be caused by
mandatory fields lacking data.

• -1016: Mandatory links are not present. For example, the parent company or
person of an activity (MA) is not included in the package.
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3
Packages
Use packages to collect and manage changes you have made to the default
configuration of Aurea.CRM and distribute them to other systems.

A package is the root element that encapsulates all configuration items via processes,
see Processes on page 36 . A package can include the following:

• A description, which is included in the package documentation, see Description
on page 24 .

• A package history, which can include automatic and manual entries, see History
on page 25 .

• Processes, which in turn can contain configuration items, see Processes on page
36 .

• An automatic version number, see Package Version Number on page 26 .

• Hyperlinks and descriptive documents.

Defining a package involves the following steps, see Developing a Package on page
34 :

1. Customizing the application in Aurea.CRM. This involves defining configuration
items, such as formats, the data model, records, designer units etc. Refer to the
corresponding manuals for more information on configuring Aurea.CRM.

2. Creating a package and entering a description for the package, see Creating a
New Package on page 35 .

3. Defining the processes in the package and adding the appropriate items to the
processes, see Editing a Process on page 40 .

4. Creating documentation, see Documentation on page 100 .

5. Exporting the package from the development system and importing it into the
production system, see Importing and Exporting Packages on page 60 .

6. Updating the package and documentation on the development system and updating
the production system, see Updating Packages on page 72 .

The package is stored in the Aurea.CRM database itself. Packages are displayed
in the Formats info area.

If you make changes to the data model in Aurea.CRM, you need to refresh
CRM.cockpit in order to view the updated data model in the data model explorer,
see Data Model on page 28 .
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Structure of a Package
Learn about the hierarchial structure of CRM.cockpit.

Packages are structured hierarchically, and contain the following elements:

• Processes: Any number of processes can be added to a package, and
configuration items are added to processes.

• Configuration items: Any number of items can be added to a process, although
each item can only be added to each process once.

The hierarchical nature of a package is apparent from the breadcrumb navigator
and can be displayed using the Tree View option, see Tree View on page 28 .

You should group configuration items in processes according to related items, as
you can determine which processes to include in the .zip file when exporting a
package.

Note: You cannot define a hierarchy of processes (i.e. add processes to processes).

Items can be added to a process manually, see Editing a Process on page 40 . If
an item is added that references other items (e.g. a rights format that references a
trigger format), the referenced items (with some exceptions) are also added to the
process automatically, see Items in a Process on page 50 .

The following can be added to the package, processes and configuration items:

• A description that documents the functionality of the element, see Description on
page 24

• History entries used to document changes made to elements, see History on page
25

• Hyperlinks relating to the element

• Descriptive documents relating to the element

You only need to enter a description for a configuration item once; the description
is shared by all references to the item. A configuration item can only be added to
each process once.

Note:  Adding a custom info area or catalog to a process automatically adds the
entire data model.

Packages are stored in the Aurea.CRM database on the development system. The
package history includes the history of all items and processes in the package, as
well as the history of the package.
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Description
Learn about the description package.

The following information is displayed on the description page:

• Information on the package version (only in the package description), see Package
Version Number on page 26

• Title

• Subtitle

• Author

• Description of the package, process or item

• Entries in the history, see History on page 25

• Hyperlinks

• Descriptive documents

You can collapse and expand the individual sections by clicking on the small up or
down arrows to the left of the headings. In the screenshot above, the history has
been collapsed.

You should always enter information under Description that describes the function-
ality of the package, process or item for documentation purposes.
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To enter the description of a package:

1. Click on Description in the icon bar or select View > General > Description from
the menu.

The description page is displayed. This description page includes the package
description, package history, hyperlinks and any attached documents. In addition,
the package description includes a version number, see Package Version Number
on page 26 .

2. Click on the  icon next to Description. A dialog box opens.

3. Enter the description of the package in the dialog box and confirm with OK.

4. Enter a Title, Subtitle (used on the title page by documentation generated by
CRM.cockpit) and Author in the same manner, see Documentation on page 100 .

You can also add entries to the package history, attach documents or define hyper-
links by clicking on the  icon next to the appropriate option:

• Hyperlinks: You can enter a URL to be associated with a process or item. Add
"http://" to the star t of the URL to ensure that links are opened correctly from
within your documentation. Clicking on the URL in CRM.cockpit opens the page
in your default browser.

• Descriptive Documents: You can associate documents with processes and items.
You can choose to add a document from Aurea.CRM's database or from your
local file system. Either browse to the desired file or search for and select the
desired document in the Aurea.CRM database. If you add a file from your file
system, the file is added to the Aurea.CRM database.

Once you have added a file, click on the hyperlink to open the document in the
associated application.

Image files (PNG, 24-bit BMP, JPG) added to items are embedded in the appendix
when generating documentation, see Documentation on page 100 .

• Select an item using its check box and click on  to delete an item.

Note: You cannot delete history items.

History
Learn about the history package.

Click on History in the icon bar to display the package history.
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Entries are automatically added to the package history whenever:

• The package is saved

• The package is exported

• A new package is created

• A process is renamed, added or removed from the package

The package history also displays the history for all items in the package.

You can add items to the history manually in order to document any changes you
have made:

1. Click on the  icon to add an item to the history.

2. Enter the desired text in the dialog box and confirm with OK.

3. The item is added to the history along with a time stamp (the system's current
time) and the name of the current user.

Package Version Number
Learn about the version number of package.

The version number assigned to packages is composed of 4 numbers, e.g. 7.1.4.9.

• The first and second numbers indicate the version and service pack of the
CRM.cockpit installation used to develop the package; in the above example,
version 7.1.

The third number is the cockpit package version number. The version number
needs to be entered manually. This number is initially set to 0.
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To enter the cockpit package version number:

1. Click on Description in the icon bar.

2. Click on  next to Version No.

3. Enter a version number higher than the current version in the Cockpit Package
Version field.

• The four th number is incremented each time the package is exported. In the above
example, the package has been exported 9 times. This number is initially set to
0.

When exporting formats, the current package version number is written to formats
where no version number is entered, or which have been updated/added since the
last export, see Format Versions on page 56 .

Content
Learn how to display the contents of your package grouped by item type.

Click on Content in the icon bar to display the contents of your package grouped
by item type.

The number of items of each type in the package is indicated in parentheses. Click
on  to display a breakdown of the number of formats or records by type.

Click on an item type to display a list of all items of that type. Click on an item to
display the overview of that configuration item, see Item Overview on page 48 .

27AUREA CONFIDENTIAL

Content



Tree View
Learn how to display the contents of your package as a hierarchical tree.

Click on Tree View in the icon bar to display the structure of your package as a hi-
erarchical tree. Processes form the top level in the tree view.

Click on the "+" to expand the tree and "-" to collapse it. Click on Expand All and
Collapse All in the header to expand or collapse the entire tree. The tree view
displays the relationships between individual items in the package.

You can consequently display an overview of complex dependencies between items
in a single screen. For example, rights formats can include a large number of child
formats, which are automatically referenced when the parent access rights are added
to the package, see Items in a Process on page 50 . In the tree view, you can easily
display the relationships between these formats.

Data Model
Learn about the data model used by the Aurea.CRM database.

Click on Data Model in the icon bar to browse the data model used by the Aurea.CRM
database. The data model consists of info areas, fields and catalogs.
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When developing a base package on station 10,000, only those items are displayed
that are common to all ver ticals, see Base Packages on page 31 .

Note:  If the data model is edited while CRM.cockpit is open, click on Refresh Data
Model to refresh the data model in CRM.cockpit.

The info areas present in the data model are listed on the left and are sor ted by info
area number. The info area code (ID), info area name and the number of fields
present in the info area are displayed. Click on a column header to sor t the entries.

Click on the name of an info area in the list to display the fields in the info area and
the info area relationships. Alternatively, enter the info area code in the Go to table
field.

The number, name, length, type, and attributes of the fields in the selected info area
are displayed, as well as the part of the data model the field is present in. The fixed
field and info area names are displayed in parentheses in gray.

The following entries are possible in the Core column:

• Core: Indicates that the field is par t of the hard-coded core data model. These
fields have a field ID < 4000.

• VirtualCore: Indicates that the field is par t of the hard-coded core data model.
However, the field is a vir tual field; i.e. the field does not correspond to a column
in a database table, but the value in the field is taken from a special field or fields
which encode this information. These fields have a field ID of 4200 - 4299.

• UniqueCore: Indicates that the field is par t of the hard-coded core data model
and has a unique field ID > 3999 (e.g. Tenant, Currency).

• GenericCore: Indicates that the field has been defined on a base station, see Base
Packages on page 31 .
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• GenericUpdate: Indicates that the field has been defined as part of the custom
data model by update on a station with a station number >10,000.

• GenericPartner: Indicates that the field has been defined as part of the custom
data model on a par tner station.

• GenericCustomer: Indicates that the field has been defined as part of the custom
data model by a customer.

• WebCustomField: Indicates that the field is a custom field defined in
CustomFields.xml.

Click on <Show legend> to display the legend. Different icons are used to indicate
different field types.

The child and parent info areas of the selected info area are displayed above the
list of fields. Click on one of the listed info areas to switch the display to that info
area. Move the mouse cursor over an abbreviation to display information on the link
between the info areas.

• Click on the number of a field to display the info areas that contain a field with
the same name. Note that fields with the same name do not necessarily have the
same functionality in different info areas. Select one of the info areas from the
list to switch the display to that info area.

• Click on a catalog ID to display all other info areas that access the same catalog.

Fields
Learn how to display references for specific fields.

You can display all references for a specific field. To do so:

1. Click on Fields in the icon bar.

2. Select the desired Info Area and the Field in the info area. You can only select
fields that are referenced by items in the current package.

3. Click on OK.

4. Information on the field is displayed, as well as all references in the package
involving the selected field.
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Base Packages
Base packages are packages that only contain items that are common to multiple
verticals, and can be imported into any supported ver tical's database.

Base packages can only be defined on stations with station numbers 10,000 and
10,010-10,014. When defining packages on a base station, only those items (info
areas, fields and catalogs) common to all supported ver ticals can be added to the
package. Designer units are only displayed if they have been defined accordingly
(i.e. ver tical ID = 0), >> Number Ranges in Aurea.CRM in the CRM.core Administrator
Guide.

Note that some base info areas have different codes and/or fields and field numbers.
These info areas and fields share a common base info area code and field numbers,
which can be used in XML reports and to define variables. These base IDs are dis-
played in the corresponding item's overview, alongside the ver tical-specific ID
(taken from the ver tical version of the database used to define the base package,
i.e. if you are using a BTB database to define the base package, the ver tical-specific
IDs displayed are those used by the BTB vertical).

When exporting the package, the base ID is included in the ZIP file. The IDs are
then converted to the appropriate ver tical IDs when importing the package into the
target database. Items whose ID has been converted in this manner are assigned
the status "Converted" and listed in the import summary.

The following table lists the available base station numbers and the number ranges
used by fields, catalogs etc.:

Lan-
guages

IndicesLinksVariable &
Fixed Cata-

logs

FieldsInfo AreasStation
No.

1-499100-
199

150-1746000-69996000-6999A0-50010,000

1-499500-
599

25-297000-719913000-
13499

A500-59910,010

1-499600-
699

30-347200-739913500-
13999

A600-69910,011

1-499700-
799

35-397400-759914000-
14499

A700-79910,012
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Lan-
guages

IndicesLinksVariable &
Fixed Cata-

logs

FieldsInfo AreasStation
No.

1-499800-
899

40-447600-779914500-
14999

A800-89910,013

1-499900-
999

45-497800-79991500-15499A900-99910,014

The following restrictions apply to base packages:

• Stocktaking and migration formats cannot be transferred between ver ticals.
Stocktaking formats can be added to base packages, but can only be imported
into the same vertical version as the format was taken from (i.e. if the base station
uses the BTB vertical, stocktaking formats added to the package can only be used
by the BTB vertical).

• References to fixed catalog values in Variable values (Z6) records need to be
manually corrected after importing the package, if the fixed catalog's codes differ
between the ver tical used by the base station and the target station.

• Fields numbers in variable conditions (i.e. defined in the Variable values (Z6)
info area) are not automatically converted to the corresponding field number when
importing the package on a different ver tical than that used by the base station.
update therefore recommends always using the base field numbers when defining
variable conditions, >> Vertical Independent Configuration on page 32 .

Vertical Independent Configuration
Learn about the ver tical independent configuration.

The data model on base stations (station numbers 10,000 - 10,014) only contain
those info areas, fields and catalogs present in all ver ticals. All ver tical-specific el-
ements are hidden or displayed as inactive (e.g. when defining access rights). This
allows you to make general changes to the data model on this base station and
distribute the changes to packages for individual ver ticals.

Base elements (info areas, fields, catalogs) are identified by special IDs:

Info Areas

• Base info areas: Info areas that are identical in all ver ticals (e.g. Rep (ID),
Station (AS) etc.) use the common info area ID. Use the --writedbstr parameter
to generate the file mm_rel_core.txt, which contains a list of all common info
areas, >> mmba.exe Parameters in the CRM.core Administrator Guide.

• Base info areas with different codes: Info areas whose contents are identical,
but whose info area codes differ have an additional base info area code which is
used in XML reports and to define variables (in the Variable info area).
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Info AreaBaseFSBCBB

Exchange Rate0WKWKWTWK

Relationship level0BLB5B5BL

Allocation0BZ-ZUBZ

Participant0RO-PARO

Sales Area (Partner)0VP-VEVP

Stock0B6B6BSB6

Stock Control0B7B7BVB7

Stock Control Item0B8B8BPB8

Receipt Transaction Type0BABABLBA

Installed Base Item0KO-IPKO

• Info areas containing base fields: Info areas present in all ver ticals, but whose
fields are only par tially identical (e.g. Company) use base field numbers for the
common fields. Use the --writedbstr parameter to generate the file
mm_dbfnr_core.txt. This file contains the common fields in these info areas
together with the common field numbers, >> mmba.exe Parameters in the
CRM.core Administrator Guide.

Fields

The following number ranges apply to base fields (see above):

CommentVerticalField Number

For all ver ticalsBase1000-1999

BTB + OTC2000-2499

BTB + FS2500-2999

OTC + FS3000-3499

The file mm_dbfnr_core.txt contains all base fields and the base field numbers (see
above). Base fields numbers are displayed as the third field number in the window
containing all fields in an info area, >> Displaying all Fields in a Mask in the
CRM.core Administrator Guide.
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Catalogs

Base catalog numbers exist for variable catalogs using the following number ranges:

CommentVerticalCatalog Number

For all ver ticalsBase20000-22999

BTB + OTC23000-23999

BTB + FS24000-24999

OTC + FS25000-25999

The file mm_catno.txt contains the base catalog number for base catalogs (in the
last column), >> mmba.exe Parameters in the CRM.core Administrator Guide.

There is no differentiation between base and ver tical-specific fixed catalogs. Ver-
tical-specific fixed catalogs are located in the number range 10-29. Please note that
the order of catalog entries (and consequently their index) may differ between ver-
ticals (e.g. in the Activity info area).

Developing a Package
Learn about the steps of developing packages.

Packages can be created purely for documentation purposes, or in order to deploy
a configuration on a different system.

Developing a package involves several steps:

Configuring the application

Configuration items are configured in Aurea.CRM. Before you can add items to a
package in CRM.cockpit, you therefore need to make the desired changes to the
application in the corresponding areas. Once you have configured the items in the
Aurea.CRM and CRM.designer databases, they can be added to processes in the
package.

Creating a Package

Select File > New from the menu to create a new package, if necessary, see Creating
a New Package on page 35 .

Click on Description and enter a description for the package describing its function-
ality for future reference, see Description on page 24 . The package description
does not need to go into specifics; add descriptions to individual configuration items
to explain their specific functionality.
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Editing the Package

Processes need to be added to the package, and configuration items from the Au-
rea.CRM and CRM.designer databases are assigned to these processes. Click on
Processes in the icon bar and click on New in the header to add a new process to
the package, see Processes on page 36 .

Edit the process by adding items, see Editing a Process on page 40 . If you add an
item to a process that references other configuration items, these items are normally
also included in the process, see Items in a Process on page 50 .

Note: You can prevent related items from being included in the package for an item
by enabling the item's check box and clicking on Do not include all dependencies
(see Adding Items to a Process on page 40 ), or in the options (see Options on page
98 ).

An overview of all the items included in a process is displayed in the process
overview.

In general, this step of the process is not a linear one. Changes may be made to
items in the Aurea.CRM database, or new configuration items may be added after
the package is created. Synchronize your package with the database to display the
items that have changed since the last synchronization, see Synchronizing Packages
on page 57 .

Creating Documentation

Once your package is complete, you can output documentation that includes infor-
mation on all the items and processes in your package, see Documentation on page
100 . The descriptions you entered for the elements in the package are also included
in the documentation. You can determine what information to include in your docu-
mentation.

Transport Management

To deploy the package on another system, the package needs to be exported from
the development system and imported on the production system, see Importing and
Exporting Packages on page 60 .

Creating a New Package
Learn how to create a new package.

1. Select File > New from the menu to create a new package.

If you have not saved your current package, you are prompted to do so.

Note: The first time you star t CRM.cockpit, an empty package is created
automatically unless you import a package from a .zip file.

2. Once you have created a new package, you should enter a description of the
package, see Description on page 24 .
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3. Add processes to the package, see Processes on page 36 .

4. Add the items you require to your processes, see Editing a Process on page 40
.

5. Save the package.

Processes
Any number of processes can be added to your package. Items are added to
processes.

Processes can contain the following configuration items:

• Formats

• Info areas

• Catalogs (fixed and variable)

• Files (e.g. JavaScript or XSLT files)

• Directories

• Designer units

• Designer configurations

• Records

When exporting the package, you can determine which processes are included in
the .zip file. Consequently, group your configuration items according to related
processes, so that you can select the appropriate processes to export to your target
system (e.g. for an update).

You can either add a new process to the package (see Adding a new Process on
page 36 ) or add an existing CRM process defined in the CRM Process Configura-
tion table in Aurea.CRM win (see Adding a CRM Process on page 37 ).

Adding a new Process
Learn how to add a new process to a package.

To add a new process to the package:

1. Click on Processes in the icon bar. The Processes page is displayed.

2. Click on the New button in the header to add a process.

3. Enter a name for the process in the resulting dialog box.

4. The new process is now listed as a hyperlink.

You can now click on the hyperlink to switch to the process.
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Adding a CRM Process
You can add an existing CRM process defined in the CRM Process Configuration
info area in Aurea.CRM win to your package.

Note:  Only processes in the first two levels of the process tree can be selected.

To add a CRM process to a package:

1. Click on Processes in the icon bar. The Processes page is displayed.

2. Click on the Select CRM Process button in the header.

The processes defined in the CRM Process Configuration info area are displayed
in a tree.

3. Select the desired process in the tree and click on OK.

Note:  Only the CRM processes in Aurea.CRM win are displayed; processes
defined in CRM.designer are not displayed.

4. The selected process is now listed as a hyperlink.

Note:  Processes are displayed in a linear fashion in CRM.cockpit. Processes
cannot be added hierarchically to reflect the structure in the CRM Process
Configuration info area.

5. Click on the hyperlink to switch to the process.

Note:  CRM processes cannot be renamed in CRM.cockpit.

Deleting a Process
Learn how to delete a process from a package.

To delete an entire process:

1. Enable the check box(es) next to the process(es) you wish to remove on the
Processes page.

2. Click on Delete in the header.

3. Confirm the prompt.

Note:  If deleting a process removes the last reference to an item in the package,
the description entered for that item is also deleted.
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Renaming a Process
Learn how to rename a process.

To rename an existing process:

1. Click on Processes in the icon bar.

2. Enable the check box next to the process you wish to rename.

3. Click on Rename in the header.

A dialog box opens.

4. Enter the new name of the process in the dialog box and confirm with OK.

The process is renamed.

Process Overview
Learn how to display a process.

To display a process, click on the hyperlink to the process on the Processes or
Contents page.
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You can enter a description, add entries to the history, add hyperlinks and attach
documents, as with packages, see Description on page 24 and History on page 25
.

The items that have been added to the selected process are listed under Referenced
Items. Click on  to hide the list of items in a category. Click on  to display the list
of items in a category. Formats in the process are grouped by type. Click on Expand
All/Collapse All next to the Formats heading to expand or collapse the display of
all formats in the package.

The items' descriptions are displayed next to the item. If the description is longer
than the text displayed, hover the mouse cursor over the description to display the
full description.

Click on one of the items to switch to an overview of that item, see Item Overview
on page 48 .

You can also add items to the process from here, see Adding Items to a Process
on page 40 .
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Note:  Each configuration item can only be manually added to a process once.
However the same item may be added automatically as a reference multiple times.
If a description is entered for an item that has been added to the package more than
once, the description applies to all references to the item. Deleting the last reference
to an item also removes the description.

Editing a Process
Learn how to edit a process.

When editing items in a process, remember the following:

• If a description is entered for an item that has been added to the package more
than once, the description applies to all references to the item. Deleting the last
reference to an item also removes the item description.

• Adding items from the data model (custom catalogs and info areas) automatically
includes the complete data model in the process, unless the Do not include all
dependencies option is set for the item. The data model is only included in the
package once. However, it makes sense to add individual catalogs and info areas
manually in order to document them.

• Adding a designer unit automatically adds the complete designer configuration
to the package. The designer configuration is only included in the package once.
However, it makes sense to add individual designer units manually in order to
document them.

Adding Items to a Process
Learn how to add items to process.

To add items to a process:

1. Switch to the process.

2. Click on  next to Referenced Items and select the appropriate item type from
the list.

For details on adding files, see Adding Files to a Package on page 45 .

For details on adding multiple files in directories, see Adding Directories and Files
to Packages on page 46 .

For details on adding multiple records that meet specific conditions to a package,
see Adding Multiple Records Based on Conditions (Groups) on page 43 .

3. For most types of items, a list is displayed from which you can choose which
items to add to the package. Only the items that you have the necessary rights
to access are displayed. Restrict the data that is displayed in the list by clicking
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on the letters above the list. Within the list, items already present in the package
and the current process are indicated:

•  indicates that an item is par t of the current process.

• indicates that an item has been added directly to a process. Move the mouse
cursor over the icon to display the processes that reference the item.

•  indicates that an item is otherwise included in the package (i.e. is referenced
by other package items).

If you are adding a format, designer unit or record, you need to select the type
from the list on the left. All items of the selected type are then listed to the right.

If you are adding a format, additional columns are displayed.  indicates a locked
format;  indicates a private format. The Distr. Code 1/2 columns display content
of the format's Distrib. code 1 and 2 fields.

Note:  Private and locked formats should not be included in your packages (unless
the owner is the SU). Private formats cannot be exported, and locked formats
cannot be updated when importing the format into the target database.

4. Click in a column header to sor t entries according to values in the column.

5. Click on Select All <Item Type> in the header to add all items of the current type.
Click on  to add/remove all the items currently displayed in the list. Enable the
Select all <item type> of this type check box in the table header (only applicable
to formats, designer units and records) to add all items in the list (e.g. all r ights
formats) to the package.

6. When adding records and formats, you can define a filter to restrict the records
displayed in the list. Click on  (Define Filter) to define a filter. A dialog opens.
Enter the filter in the Filter field using the following syntax:

• Specify fields using "F<field number>" (the 'F' must be capitalized), e.g. "F2"
refers to the contents of field 2 in the info area (e.g. Company in the Company
info area). You can apply conditions to a number of fixed fields in all info
areas/formats; these fields are listed in the Define Filter dialog.

• You can reference catalog values using the catalog entry's text or by index
using the # prefix (e.g. F3=#2 to compare the contents of field 3 to the catalog
value with index 2).

• The following comparison operators are supported:

= (equal)

<> (not equal)

> (greater than)

< (less than)
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>= (greater than or equal)

<= (less than or equal)

• When comparing Boolean fields:

An empty comparison value corresponds to false

Any other comparison value corresponds to true

Example: "F23=" compares the value in field 23 to false.

• The following logical operator is supported to link conditions:

& (AND)

Note: The following restrictions apply to these conditions:

Note:  + You cannot use brackets in these filters.

Note:  + You cannot use the & and # characters in comparison values.

Click on OK to apply the filter. Click on  (Clear Filter) to clear the filter and
display all records/formats.

7. Enable the check boxes next to the items you wish to include.

8. Click on Add Selected Items in the header to add the selected items to the
package.

Note: When adding triggers and workflows and designer items, the Description
entered for the item in the database (or the Accomp. Text in the case of triggers)
is automatically transferred to the item's Description in the package in the
language entered in the <AutomaticDescription> element in the Settings.xml

file. To update other descriptions, switch to the view of the item and click on 
(Update Description) next to the Description header to transfer the updated
description in Aurea.CRM to CRM.cockpit.

9. The display returns to the process and the items you have added are listed under
Referenced Items.

Note the following:

• Adding an item to a process generally adds all items referenced by the item as
well. There are some exceptions however. For fur ther details on the data added,
see Items in a Process on page 50 .

• To prevent dependent items from being included for a format, info area or catalog,
enable the check box next to the desired items and click on Do not include all
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dependencies. The  icon next to the items indicates that only the item itself is
included in the package, not its dependent items. Enable the check box and click
on Include all dependencies to include all related items in the package again.
This option can be enabled by default for new items, see Options on page 98 .

Note: This option is intended for applying updates to existing items in the package
where the dependent items have not been changed. The dependent items still
need to be present on the target system (i.e. from a previous import), otherwise
the import fails.

• When adding Variable (Z5) records, all child Variable values (Z6) records are
automatically added to the package.

• If you add a custom info area (defined in the Data Model info area in Aurea.CRM's
Maintenance module) to a process, the entire data model is added to the process.
However, it still makes sense to add info areas individually for documentation
purposes.

• Some formats cannot be included in packages, see Item Restrictions on page 51
.

• If you add a custom catalog (defined in the Data Model info area in the
Maintenance module) to a process, the entire data model is added to the process.
However, it makes sense to add individual catalogs for documentation purposes.

• If you are using catalogs or formats in multiple languages, you need to add the
corresponding language records to the package, see Items in a Process on page
50 .

• If you add a designer unit to a process, the entire designer configuration is added
to the process. Add individual units for documentation purposes. Some designer
units cannot be included in packages, see Item Restrictions on page 51 .

• Documents referenced by document fields in records need to be added manually,
see Items in a Process on page 50 .

• When defining a base package (on station 10,000, see Base Packages on page
31 ), only items common to all 3 ver ticals are listed. Designer units can only be
added to base packages if the unit's ver tical ID is 0 (zero).

Adding Multiple Records Based on Conditions (Groups)
Learn how to add multiple records based on conditions.

Groups allow you to define conditions that determine which records in an info area
should be included in the package.

Note:  If you apply the Do not include all dependencies or Include all
dependencies option to a group, the option applies to all records in the group. If
Do not include all dependencies is enabled, only references to these records'
parent records and mandatory links are included in the package.Do not change
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this flag once you have performed the initial export, otherwise subsequent upgrades
may cause data inconsistencies in the target database.

To add a group:

1. Click on  next to Referenced Items and select Group.

2. Select the info area you want to include records from.

3. Enter a Name for the group. If you do not enter a name, the URI is displayed
instead in CRM.cockpit.

4. Define the conditions used to restrict the records that should be included in the
package. If you do not define a condition, all records are included. These
conditions are applied each time the package is exported (i.e. records that meet
the conditions at the time of export are included in the package). The conditions
are also re-evaluated if you refresh the package with Check Unit Availability.

The following options are available:

• Define by using filter tree: Provides a graphical overview of your conditions
and allows you to define conditions using the GUI. To define the filter:

Click on  to edit the filter.

Right-click on the white area and select Add a new field from the [info area] info
area.

Select the field you want to apply a condition to and define the condition.

The condition is displayed in the tree:

Right-click on the field name and select Add a new field from the [info area] info
area to apply a condition to an additional field. Select Add new condition for field
[field] to define an additional condition applied to the same field.

By default, conditions are linked using a logical AND. Right-click on an AND or OR
operator and select Change to OR/AND to change the operator. Select AND or OR
to add a new operator to the tree, and right-click on the new operator to define the
conditions linked via the operator.

1. Click on Check Filter in the header to test the filter. If the filter is defined correctly,
a list of records matching the filter criteria is displayed.

2. Click on Add Selected Items in the header to add the group to your package.

Note:  If you apply conditions to records in the Format (FT) info area, only those
records are included in the export that are supported by CRM.cockpit, see Item
Restrictions on page 51 .
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Sub-groups

Sub-groups allow you include records in child info areas based on the conditions
applied to the parent info area (group). You can define additional conditions applied
to the child info area that need to be met in addition to the criteria applied to the
parent info area.

For example, you can include all questionnaires (F1 records where Type = "Ques-
tionnaire") by defining a group. You can then add a sub-group to include all question
(F2) records in the questionnaires, and a fur ther sub-group (a child of the question
sub-group) to include all answer (F3) records for the questionnaires.

To add a sub-group:

1. Navigate to an existing group.

2. Click on Add Subgroup in the header.

3. Select the info area you want to include records from. Only info areas that are a
child of the info area selected in the parent group can be selected.

4. Enter a name for the sub-group and define any filters applied to the records in
the child info area as described above.

5. Click on Add Selected Items in the header to add the sub-group to your package.

Adding Files to a Package
Learn how to add files to package.

Import Settings on page 79 You can add individual files to a package. For details
on adding multiple files and directory structures to a package, see Adding Directories
and Files to Packages on page 46 . To add a file to the package:

1. Switch to the process.

2. Click on  next to Referenced Items and select File from the list.

3. Select the file you wish to include from the file system.

4. Files can be either stored as documents in the Aurea.CRM database on the
development system or on your local file system. Select the appropriate option
under Embed file as:

• document in the Aurea.CRM database: The selected file is saved in the
Documents table in the Aurea.CRM database on the development system.

• file name only: Only the path to the file is stored in the Aurea.CRM database.
If you use this option, ensure that all users who export packages can access
the required file paths.

5. Enter the Destination directory for the file on the target system. When importing
the file on the target system, the file is copied to the destination directory on the
target system and the file path on the target system is updated. You can use
placeholders in the path name. Define placeholders using the '$' character followed
by the name of the placeholder, e.g. '$WEB'. The placeholder continues until the
next '\' character or until the end of the path if no '\' follows the placeholder. You
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can use multiple placeholders in the same path (e.g.
'$DRIVE\$WEB\$FILE_DIRECTORY').

Note:  A placeholder cannot consist of only the $ character (e.g. '$' and '\$\foo'
are invalid) and cannot contain multiple $ characters one after another (e.g.
'$$FOO').

Always use the '$WEB' placeholder for files used by Aurea.CRM web and Au-
rea.CRM web offline, as CRM.cockpit checks for files containing the '$WEB'
placeholder when importing a package if the Deploy web offline files option is
enabled. update also recommends using '$WIN' as the placeholder for the Au-
rea.CRM win installation directory.

When importing the package, you are asked to select directories to replace your
placeholders, see Importing Packages on page 65 . If you are using the command
line to import packages, define the target directories for placeholders in the XML
file used to define the import settings, see Import Settings on page 79 .

Generally, files in a package are configuration files, such as XSLT stylesheets or
JavaScript files for Aurea.CRM web.

Adding Directories and Files to Packages
Learn how to add directories and files to package.

To add a directory and all files in the directory to the package:

1. Switch to the process.

2. Click on  next to Referenced Items and select Directory from the list.

3. Select the directory on the source system you wish to include in the package in
the dialog.

4. Enter the Destination directory on the target system. The destination path can
be absolute or relative to the CRM.cockpit directory on the target system.

You can also use placeholders (e.g. "$WEB"). When importing the package, you
are asked to select directories to replace your placeholders, see Importing
Packages on page 65 . If you are using the command line to import packages,
define the target directories for placeholders in the XML file used to define the
import settings, see Import Settings on page 79 . While you can use any place-
holder star ting with '$', update recommends using $WEB for Aurea.CRM web and
$WIN for Aurea.CRM win.

Note:  A placeholder cannot consist of only the $ character (e.g. '$' and '\$\foo'
are invalid) and cannot contain multiple $ characters one after another (e.g.
'$$FOO').
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Note:  During the import process, the paths in file and directory items in the
package are converted to the paths on the target system.

5. You can enter a Filter to restrict the files that are included in the package (e.g.
"*.xml" to only include XML files). If you do not enter a filter, all files in the directory
are added to the package.

6. Enable Include sub-folders to add all sub-folders in the source directory to the
package as well. Any sub-folders missing on the target system are added when
importing the files.

Note:  Directories whose name star ts with a single period (.) are ignored.

7. Click on Add Selected Items in the header to add the directory to the package.

Deleting Items from a Process
Learn how to delete an item from a process.

To delete items:

1. Enable the check box next to the item(s) you wish to delete.

Note:  Click on Select All to select all items in the current process.

2. Click on  (Remove Item) to remove the references to the selected items from
the process.

3. You are asked to confirm the deletion. Click on Yes.

Configuration Items
Learn how to add configuration items to a process.

Configuration items are added to processes, see Editing a Process on page 40 .

The following items can be added to processes:

• Formats

• Info areas

• Catalogs (fixed and variable)

• Files (e.g. JavaScript or XSLT files) and directories

• Designer units

• Designer configurations

• Records
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• Groups (and sub-groups), used to include records from specific info areas (and
child info areas) that meet cer tain conditions, see Adding Multiple Records Based
on Conditions (Groups) on page 43

• Fields

Note:  Fields cannot be added to processes manually. Fields are added automatically
if they are referenced by either records or formats.

Not all formats and designer units can be included in a package. For a list of formats
and designer units that cannot be added to a package, see Item Restrictions on
page 51 .

The following information is displayed in parentheses for items:

• Info Areas: The info area abbreviation

• Formats: The format type

• Fixed Catalogs: The first info area using the catalog and the catalog number

• Variable Catalogs: The catalog number

• designer units: The unit type

• Files and directories: The target path

• Records: The info area code and record key

Item Overview
Click on the name of an item to display an overview of that item.

The item overview is similar to the process overview, and also includes a description
and history, see Description on page 24 and History on page 25 . Fur ther information
is displayed depending on the selected item type.
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Items referenced by the selected configuration item are listed (except in the case
of the data model format, for performance reasons). Click on the name of an item
to switch to that item.

Note:  Records in the Variable (Z5) and Variable values (Z6) info areas are
exceptions; the info areas and fields referenced by these records are not displayed
and are not automatically added to the package.

All items which reference the selected configuration item are also listed. Click on
the name of an item to switch to that item.

If the current item is a trigger, workflow or generic form, click on  to transfer the
entry in the Description (workflows and generic forms) or Accomp. Text field
(triggers) to the item's description in CRM.cockpit.

The following information is displayed for items on base development stations,
see Base Packages on page 31 :

• Info areas: The base ID, in addition to the ver tical-specific ID (taken from the
vertical version used by your current station).

• Fields: The base field ID, if it exists, in addition to the ver tical-specific field ID
(taken from the ver tical version used by your current station).

• Variable catalogs: Only the base catalog number is displayed for variable
catalogs.
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Displaying the Contents of Files
Learn how to display the contents of files.

To display the contents of a file:

1. Switch to the overview page for the desired file.

2. Click on Show in the header.

The file is displayed.

Items in a Process
Items in processes are added as references to the item in the Aurea.CRM database.

The actual item (format, file etc.) is only included in the .zip file generated when
the package is exported. You can therefore edit the items in the Aurea.CRM
database, and the latest version is included whenever the package is exported.
Synchronize the package with the database to view those items included in the
package that have been edited or deleted in the Aurea.CRM database since the last
synchronization, see Synchronizing Packages on page 57 .

When an item is added to a process, all items referenced by that item are also
added, unless you have chosen not to include all dependent items (Do not include
all dependencies option).

Note:  If you enable Do not include all dependencies for a record, references to
parent records and mandatory links are still included in the package.

The following is included for each type of item:

• Info Area: No other items are added.

• Format: Fields, info areas, catalogs, document records, rep records and other
formats referenced by the format are also added to the package.

• Catalog: The catalog and all its entries are added to the package. If the catalog
is a child catalog, the parent catalog is also added.

• designer Unit: The configuration containing the selected designer unit is added
to the package, as are all users and user groups that use the configuration. Parent
configurations are also added to the package, except for the configurations
supplied by update (e.g. UPDATE_DEFAULT etc.).

• File: Files added to the Aurea.CRM database include a reference to the document
record in the Documents info area (D1).

• Record: A reference to the info area is automatically added to the package. If a
record includes catalog values, a reference to the appropriate catalog is also
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added. Any records which are linked to the selected record via a 1-1 or 1-n
relationship are also added automatically.

• Group: All records in the selected info area that meet the condition are added to
the package. The condition is re-evaluated whenever the package is refreshed
(Check Unit Availability) or exported.

Exceptions

You need to add the following items manually:

• The Data Model format, if you changed the text used by info areas, fields or
catalogs in the data model. Note that the Data Model format is added automatically
if you add an element from the custom data model to the package.

• Documents referenced by document fields in records

• In order to import multi-language formats and catalogs correctly, the corresponding
Language Table (00)records must be present in the package. Languages/station
(01) records added to the package and not present on the target station are
automatically assigned to the target station during import.

• Custom processes (defined in the Rights module) not referenced by any formats
in the package and that are not a parent process of any processes already added
to the package.

• Catalogs used in Variable values (Z6)

• Local extended access rights formats

• Records in the CRM Process (R4) referenced by other CRM process records;
only triggers and workflows entered in R4 records are automatically included in
the package (unless the CRM Process ID field (5) contains wildcards).

Note: The Relationship Level info area always includes two reciprocal records.
Only add one of the two records to the package. The second reciprocal relationship
is automatically added during the import process. If you add both relationships to
the package, you receive an import error, as the reciprocal relationship has already
been created and cannot be updated.

Item Restrictions
Learn about the restricted formats in a package.

The following formats cannot be included in a package, and are thus not available
for selection:

• Appointment overview display

• Archived data model

• Design data model

• Custom masks

• Individual analyses (OTC only)

• Lists
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• Mask layout

• Rep sets

• Star t page

• Search fields

• User default values

• User specific desktop settings

The following records cannot be added to a package manually:

• Catalog (KA)

• Catalog Maintenance (KW)

• Chart element (D6)

• Format (FT), although these records can be included in groups, see Adding Mul-
tiple Records Based on Conditions (Groups) on page 43

• Hierarchy Change (05)

• History (H0)

• Process Tracking (T3)

• Property Selection (OS) – BTB only

• Query Result (Q1)

• Query Result Column (Q2)

• Query Result Record (Q4)

• Query Result Row (Q3)

• Read Access Logs (T5)

• Rep Reference (10)

• Sales Funnel (AY) – BTB only

• Selection (SL)

• Session Tracking (T2)

• System Event (03)

• Tel.No./E-mail (TN)

• Telemarketing Prep. (TP)

• Text (04)

• User Tracking (T1)

• Write Access Logs (T6)

• Workflow (WF)
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Working with Formats
Learn how to work with formats.

Because of the relationships between formats (a format may reference other formats),
adding a format to the package may result in a wide range of other formats being
added to the package automatically. For example, a rights format can contain refer-
ences to a large number of other formats, such as workflows and triggers.

If you have only updated a format, but not the items it references, you can enable
Do not include all dependencies for the format (see Items in a Process on page
50 ) to only include the format in the package, without the related items. The related
items still need to be present on the target system when importing the package, i.e.
this option only applies to package upgrades.

If you edit a format on the production systems, any changes is overwritten the next
time the package is imported. To retain the edited version of the format in the target
database, you need to create a copy of the format on the production system before
editing the format, see Customizing Package Formats on the Target Station on page
54.

When transferring formats between systems, Aurea.CRM automatically keeps track
of the package version where the format was last updated (added/edited), see
Package Version Number on page 26 and Format Versions on page 56 . This allows
you to track format versions and compare the version present on various systems.

Deleting Formats
You can mark formats in the package as deleted, in order to delete the format on
the target station(s).

When deleting the format on the target station, any backups of the format are also
deleted, see Backing Up Formats on page 55 .

You cannot delete the data model format itself (including archived versions and
designs).

Note:  Marking a format as deleted is a permanent action. You cannot change the
delete status of an item marked as deleted; the delete status is retained in the
source database. The format should not be deleted on the source station until the
deletion has been applied on all target stations by importing the package.If
necessary, you can remove the format from the package and add it again, in which
case the delete flag is removed.

To mark a format as deleted:

1. Switch to the process containing the format you wish to delete.

2. Enable the check box(es) next to the format(s) you wish to delete.

3. Click on  in the header.
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4. Confirm the prompt.

5. Marking a format as deleted does not automatically update the references to the
format in the package. To update the references after removing a format, click
on Check Unit Availability, see Checking Unit Availability on page 59 .

The formats are marked as deleted and is deleted in the target database the next
time the package is imported. Formats marked as deleted are indicated with .

When importing the package on the target station, a list of the formats to be deleted
is displayed:

If you want to create a backup of these formats, you need to rename the formats in
Aurea.CRM win before clicking on OK.

Once the package has been imported, the deleted formats are marked as deleted
in the package and displayed accordingly in the process overview. This is the only
method of deleting formats transferred from stations with a station number of 10,000
or higher.

Customizing Package Formats on the Target Station
Learn how to customize formats in the package on the target station in order to
meet the specific needs of end users.

For example, access rights may include a trigger, which must be extended or other-
wise modified on the target station.

However, if you edit a format included in the package on the target station, and then
upgrade the package, the edited format is overwritten by the format in the package.
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To prevent the edited format from being overwritten when importing the package,
you need to create a back-up of the original format on the target station in Aurea.CRM
win, see Backing Up Formats on page 55 . The original format is backed up under
the name "<T>format name" ("<T>" for Template) and linked to the original format.
You can then edit the format with the original name (live format), and any references
in other formats continue to reference this format. When importing the package, the
backup of the original format (i.e. the format whose name is preceded by "<T>") is
updated. You can then update the live format on the target station if necessary.

You can revert to the backed up format included in the package by removing the
copy, see Backing Up Formats on page 55 . The live format is deleted and the
backup copy is renamed to the original name (i.e. "<T>" is removed from the format
name), meaning that this format becomes the live format and is again referenced
by other formats.

Copies cannot be created for the following format types:

• User-specific formats

• Nameless formats (e.g. data model, CRM process configuration etc.)

• cockpit packages

Backing Up Formats
Learn how to back-up formats before upgrading the template.

If you want to edit a format included in a package on the target station, you should
first create a backup of the format to prevent the edited format from being overwritten
when next upgrading the template. Creating a backup adds a copy of the original
package with "<T>" added to the star t of the format name. You can then edit the
format with the original name on the target station (the format continues to be refer-
enced correctly by other items as the reference occurs by name). When importing
the format in a package, the backup (with "<T>" in the name) is updated with the
format in the import package and the live format remains unchanged. You can revert
to the format in the package at any time.

To create a backup of the format included in a package in Aurea.CRM win:

1. Select the format in the Format info area and select Create Backup from the
context menu.

2. Click the Create Backup button in the Load and Save dialogs for formats.

"<T>" (for Template) is added to the star t of the backup copy's name. This format
is updated when importing the package. The live format is linked to the backup for-
mat. Only one backup copy is allowed per format.

To revert to the format in the package (in Aurea.CRM win):

1. Select the backup in the Format info area and select Restore Backup from the
context menu.

2. Select the live format and click on Restore Backup in the Load or Save dialog.
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The live format is deleted and the "<T>" is removed from the backup's name.

Format Versions
Learn about the format versions in CRM.cockpit.

Whenever a format is exported as part of the package, the package's version number
is written to the Version (cockpit package) field and the name is written to the
Name (cockpit package) field in the Format (FT) info area in any of the following
cases:

• The Version (cockpit package) field is empty.

• The format has been edited in the source database since the last export, i.e. the
format's modification date (Updated on field) is more recent than the last export
date.

• The format has been added to the package since the last export. Note that the
Version (cockpit package) field may already contain a version number if the
format is included in another package. update therefore recommends activating
the history for formats.

The version number is stored in the format on both the source and target stations.
This allows you to determine the package version of the last export and to determine
if the formats on both the source and target stations are identical.

Note:  If the format is not exported successfully, the version number in the Version
(cockpit package) field remains unchanged.

Example: The package (version 8.0.0.0) initially contains formats A and B. The
Version (cockpit package) field is empty in all formats.

The package is exported, but only format A is included in the export. The package's
version is automatically increased to 8.0.0.1, and is entered in the Version (cockpit
package) of format A.

The package is exported a second time, including both formats A (unchanged) and
B. The package's version number is increased to 8.0.0.2. The entry in the Version
(cockpit package) of format A remains unchanged (8.0.0.1) and the Version
(cockpit package) of format B is set to 8.0.0.2.

Undoing Changes
Learn how to revert versions in CRM.cockpit.

You can revert to the last saved version of the current package at any time. Select
File > Revert to Last Saved Version from the menu and confirm the prompt.

Note: You cannot revert to the last saved version if you have not made any changes
to the package, nor can you undo an import.
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Synchronizing Packages
Learn how to synchronize packages in CRM.cockpit.

During the development phase, a package is stored in the Aurea.CRM database on
the development system. Items within the package are only included as references
to items in the Aurea.CRM database. Items in the Aurea.CRM database can be
edited, deleted or added. Synchronize your package with the database to add new
or edited items in the database to the package, or to remove references to deleted
configuration items.

When you synchronize the package, changes made to configuration items in the
database since the selected date (default: last synchronization date) are displayed.
You can choose to add new or modified items to the package. Note that the reference
itself does not change if you edit an existing item; you do not need to synchronize
the package if you have purely modified an existing item already included in the
package.

Items included in the package that have been deleted in the database are also listed
during synchronization, allowing you to remove the references to these items from
the package.

To synchronize the package:

1. Select Edit > Wizard: Sync Package Items with Aurea.CRM database from the
menu.

2. The following dialog is displayed:

• Select a Start date to synchronize the items that have been modified since the
selected date. By default, the date of the last synchronization is selected in
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the date field. If the package has not yet been synchronized, the date on which
the package was created is selected instead.

• Select All to synchronize all items in the package that have been modified
since the specified date.

• Select Only the following items to restrict the synchronization to items in
specific info areas. Enter the info area codes (e.g. "FI" for Company) of those
info areas you wish to synchronize separated by a semicolon. The value you
enter here is stored in the configuration file when you click on OK, and is
automatically entered the next time you access this dialog, > CRM.cockpit
Settings on page 13 .

3. Click on OK to synchronize the package.

4. CRM.cockpit scans the Aurea.CRM database. This may take a while.

5. A wizard is star ted.

6. In step 1 of the wizard, all items in the Aurea.CRM database that have been added
or edited since the last synchronization process are displayed. If you are
synchronizing the package for the first time, all items changed since the package
was created are displayed.

Drag the desired items from the list of New or changed items to the desired
processes under Processes to include them in the package.

You are prompted to enter a description for any new items you add to a process.

7. Click on Next Step in the header to proceed to step 2 of the wizard.

In step 2, those items in the package that have been deleted in the Aurea.CRM
database are displayed. You can remove all references to these items in the
package.
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8. Select the items you wish to remove from the package and click on Next Step in
the header to proceed to step 3 of the wizard.

A summary of your changes is displayed.

9. Click on Finish Wizard to apply your changes.

Checking Unit Availability
Click on Check Unit Availability if you have made any changes to items in the
Aurea.CRM database.

A confirmation prompt is displayed. You can disable the prompt from the options
(see Options on page 98 ) or by enabling the Do not show this question again
check box.

A list of configuration items in the package is displayed, along with their status
("Available" or "Not Available") and the processes they are used in. Click on Save
Result to output the list of items that are "Not Available" to a text file.

Items that have been added to the package, but are no longer present in the Au-
rea.CRM database, are indicated with a red exclamation mark in CRM.cockpit.

If items are unavailable, click on Remove all unavailable items to remove all items
in the package that are unavailable in the database. Those items that could not be
removed (items not directly referenced by a process) are listed afterwards.

XML View
Learn how to view items in your package in xml format.

You can view items in your package in XML form. To do so:

1. Select View > XML Source from the menu. The Package Designer - XML Source
View window opens.

2. Select Xml from the drop-down list.

59AUREA CONFIDENTIAL

XML View



3. Navigate to the desired item. The item is displayed in the Package Designer -
XML Source View.

4. Keep the XML view open to update it as you navigate between items in the
package. The XML view is updated whenever you switch to a new item.

Importing and Exporting Packages
Learn how to transport packages.

In order to transport your package to another installation, you need to export the
package from the source system and import it on the target system. Note that both
installations require you to access CRM.cockpit; packages are both imported and
exported with CRM.cockpit. Packages can be imported and exported using both the
CRM.cockpit user interface and the command line, see Exporting Packages on page
60 , Importing Packages on page 65 and Command Line on page 74.

Note: You can define a default folder for import and export files in the Settings.xml
file (ExportFolder/ImportFolder). If you define a default folder, this path is opened
by default when selecting File > Export Package as .zip File/Import Package from
.zip File from the menu). If you do not define a default folder, the last folder used
is opened instead.

The following restrictions apply to importing packages:

• Packages can only be imported on the station configured as the Main Office (in
the Station info area), see Station in the Rights Module in the CRM.core
Administrator Guide.

• Catalog maintenance information can only be imported on the catalog maintenance
station (Aut.Cat.Maintenance option in the Station info area).

• Packages cannot be imported if a user is accessing the data model on the target
system.

Packages are exported as .zip files. You need to copy the .zip file to the target
system and then use CRM.cockpit to import the .zip file.

Note:  Any user can export a package, but only the SU can import a package.

Exporting Packages
Learn how to export the developed package.

Once your package has been defined on your development system, you need to
export the package, in order to import it on the target station. When exporting the
package, you can determine which processes to include in the .zip file.
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To export a package:

1. Select File > Export Package as .zip File from the menu.

2. Choose where to save the .zip file and enter a name. The name of the package
with the current CRM.cockpit version number, date and time appended is suggested
by default (PackageName_MajorVersion.ServicePack_YYYYMMDD_HHMM.zip).

The following dialog box is displayed:

3. Choose the Export Type:

• Full (Export all items in package): Exports the complete package including
all select items.

• Upgrade (Export all items changed since last export): Exports the selected
items in the package that have been added or edited since the version selected
under Upgrade for Template Version.
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Note:  As no time stamp is available for designer items, all designer items are
exported if selected.

If you are exporting an upgrade (i.e. have already imported a previous version
of the package on the target station), select the version of the package on the
target station under Upgrade for Template Version. All changes to selected
items (apart from designer items, see note above) in the package since the
selected version are included in the export.

When exporting an upgrade, the Catalog Maintenance Items option is always
enabled and the export settings used by the previous export are used.

4. Choose the desired options:

• Save this export for future upgrades: The number of packages that are saved
as the basis for future upgrades is limited. The default is 50 (the size of the
export history), but can be changed, see Configuring the Number of Logs Stored
in the Template on page 86 ). Enable this option to assign the current export
a higher priority. Exports where this flag is not set are removed and unavailable
from the Upgrade for cockpit Package list field before those where this flag
is set.

• This is an initial package: Enable this option if the package your are exporting
is the initial package. This option is unavailable for upgrades. This option
exports a package containing all catalog values. If this option is enabled, a
catalog maintenance entry is added on the target station when importing the
package containing the ID of the last catalog maintenance (KW) record on the
source station. When exporting from the command line, set the initial
parameter to the desired value in the XML export configuration file, see Com-
mand Line on page 74 .

• This package contains web offline files: Enable this option if the package
includes files required by Aurea.CRM web offline. This option is only active if
the package contains files that use the '$WEB' placeholder. When importing
the package, enable the Deploy web offline files option to copy the files
containing the '$WEB' placeholder to Aurea.CRM web offline's global patch
directory, see Deploying Offline Files on page 74 .

5. Determine which items in the package should be included in the export under
Items to Export. Only the selected item types are included in the exported .zip
file.

• Core Items: Includes catalogs, formats, info areas (i.e. the data model) and
records in the package.

• Catalog Maintenance Items: Includes catalog maintenance records in the
package. The catalog maintenance records are used to update catalogs on the
target station using the data from the source station (as with communication
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between stations, see Catalog Management on page 95 and Automatic Catalog
Maintenance in the Aurea.CRM win Administrator Guide).

Note: When exporting from a base station (10,000 and 10,010-10,014), deleted
catalog values are only included if the tenant number is not empty. Deleted
catalog values with no tenant assigned are ignored and not updated on the
target system.

• Text Table Items: Includes the records in the Text table in the package.

Note:  update recommends including the source station's language records in
the exported package to ensure that the data in the text table is displayed
correctly on the target station.

• Field Help: Includes the field help stored in the database. In addition to all
field help records (FH), all texts in the text table (04) are also exported that
are referenced by the field help (even if Text Table Items is disabled).

• Designer Items: Includes designer units and configurations in the package.

• Files: Includes the files added to the package in CRM.cockpit in the exported
package.

6. Click on Next.

7. Determine which processes to include in the .zip file using the corresponding
check boxes.

Click on Select All to include all processes.

If you are exporting an upgrade, click on Select Items to Upgrade to select which
items should be exported. All items that have been updated or added to the
package since the export selected in the Upgrade for cockpit Package field are
listed. By default, all items are selected.

If you remove an item (by disabling the check box) that references other items,
the referenced items are listed and you are asked whether you really want to re-
move the item from the upgrade. Disable the Disable warning for deselected
referenced items check box to suppress this prompt.

Note:  Removing items from the upgrade package means that items may not be
present in the target database; this can cause the import of the package to fail if
missing items are referenced that are not present on the target system.

8. Click on Next.

9. The following dialog is displayed:
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10.If your database contains multiple tenants, determine which catalog values to
include in the export:

• Export all catalog values: Exports catalog values irrespective of the tenant
assigned to the catalog value

• Export only catalog values without a tenant: Exports only those catalog
values where no tenant is assigned (tenant-independent values)

• Export catalog values for the following tenants: If you select this option,
you can choose the tenants whose values you want to export.

Select the desired tenants from the list of tenants on the left. Ctrl+click or
Shift+click to select multiple tenants.

If you want to export all catalog values for a specific catalog, rather than
restricting the values to specific tenants, enable the check box next to the
catalog in the list on the right. In this case the tenants you have selected are
ignored for this catalog.

Note: The tenants you select apply to all catalogs (except those where the
check box is enabled in the list). You cannot choose to export catalog values
for different tenants from different catalogs.

64AUREA CONFIDENTIAL

Chapter 3: Packages



11.If you included Catalog Maintenance Items in the package (see above), enter
the ID of the first catalog maintenance record to be exported in the Next Catalog
Maintenance ID field.

Note: The next ID is entered automatically based on the last ID that was exported.
However CRM.cockpit has no means of determining whether the catalog
maintenance records were input successfully on the target station (no receipt
confirmation). The target station tracks which catalog maintenance records have
been imported.

12.A summary of your settings is displayed. Verify that you have included the correct
processes and click on Start Export.

13.The system checks that all units included in the package are available in the
database. If items are missing, the export is canceled. You can choose to display
a summary, see Checking Unit Availability on page 59 .

14.The package is exported.

15.A message is displayed informing you of whether the export was successful or
not.

Note: The system does not verify whether your package includes all necessary
information for a successful import if you choose not to export all the processes.

Importing Packages
Learn how to import package.

Once the package has been exported as a .zip file, the .zip file needs to be imported
on the production system.

Note:  A package cannot be imported if a user is accessing the data model on the
target system. A message is displayed if this is the case. During the import process,
the data model on the target system is locked for editing and is only unlocked once
the import is complete.

When importing records, records are matched up using the primary key. If the target
database already contains records with the same key, these records are displayed
in the Match-Up dialog, see Match-up on page 73 . The station numbers therefore
need to be different to prevent records added on the target station from being
overwritten, as the record number is often part of the primary key.

Reps are matched up using the associated login. If a rep with the corresponding
login is already present in the target database, the existing rep is retained and no
new record is added. In this case, the rep record is updated with the imported rep
record.
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Exception: If reps are linked to the SU and WWW logins in the target database,
the existing records are always retained and are not updated.

Note: When importing a package into a database that already contains data, ensure
that the two station numbers are different. Records in the target database with the
same key as imported record is otherwise overwritten!

To import a package:

1. Copy the .zip file containing the package to the target system.

2. Start CRM.cockpit on the target system and log in as SU.

3. Select File > Import Package from .zip File from the menu.

4. Select the .zip file containing the package.

5. Confirm that you wish to import the package.

The following dialog box is displayed:

6. Enable Deploy web offline files to copy the files containing the '$WEB'
placeholder to Aurea.CRM web offline's global patch directory. If you enable this
option, all other options are unavailable and only the offline files are deployed,
see Deploying Offline Files on page 74 .
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7. Use the check boxes to determine which of the items included in the package are
imported. You can choose whether to import core items (Aurea.CRM win items,
such as formats, info areas etc.), designer units (for designer databases) and
files (including directories):

• Enable Import catalog maintenance items to import the catalog maintenance
information and update catalogs on the target station based on the information
in the catalog maintenance items, see Catalog Management on page 95 and
Automatic Catalog Maintenance in the Aurea.CRM win Administrator Guide. If
the zip file contains catalog maintenance records, catalog values in the package
are not imported and are ignored. These catalog values are not included in
the import log and are not matched up. This prevents existing catalog values
on the target station (which may since have been edited) from being overwritten.

If the Import catalog maintenance items option is disabled, catalogs in the
package are imported in full and overwrite the catalogs on the target station.

For more information on managing catalogs, see Catalog Management on page
95 and the CRM.core Administrator Guide.

• Enable Import text table items to import items in the Text (04) info area into
the database on the target station. The texts are imported automatically (without
match-up) and overwrite any existing text entries with the same key.

• Enable Import field help items to import all field help records in the .zip file
and all text table entries referred to by the field help (even if Import text table
items is disabled).

• Enable Files to import the files and directories in the package.

8. Enable the Update CRM.designer option to update the CRM.designer database
with the current data model, catalogs, CRM processes (R4) and roles (R2) . This
option is only available if a connection to the CRM.designer database was
established.

Note:  Field labels, catalog values etc. in CRM.designer are updated in the
language selected by the user performing the import. If you do not enable the
Update CRM.designer option, the data model, catalogs, CRM processes and
roles in the CRM.designer database are not updated when importing designer
items. This option can be specified in the import XML file in the UpdateCRMDesigner
node.
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Select how to synchronize catalog values:

• Synchronize changed or new catalogs: Any catalogs values that are added
or updated by the import process are synchronized with CRM.designer.

• Synchronize only existing catalogs: Only existing catalog values are updated
by the import process and synchronized with CRM.designer. You can choose
how to match up existing catalog values:

• Synchronize catalogs by default text and tenant no: Catalog values in
the package are matched up with catalog values in the target CRM.designer
database by the value in the catalog base language and tenant number.

• Synchronize catalogs using the external key: Catalog values in the package
are matched up with catalog values in the target CRM.designer database
using the catalog value's external key.

Note: Note: When importing via the command line, you can specify the
synchronization option in the import XML file in the CatalogSyncMode node. If
no value is specified in the XML file, catalog values are matched up by text
and tenant number.

• Do not synchronize catalogs: No catalogs are updated in the CRM.designer
database.

9. If you enable the Files option and your package contains files or directories whose
target directory includes a placeholder, you need to enter the directory to replace
the placeholder with.

Click on ... in the Select Destination Folder column to select the target directory
for the corresponding placeholder.

If you do not select a directory for a placeholder, any files using that placeholder
are not imported.

10.Click on Next.

11.If you are upgrading an existing package (i.e. importing the package over an older
version of the same package), you may need to determine which items should be
stored in the database, if items have been edited, see Match-up on page 73 .

12.Click on Next.

A summary of your settings is displayed.

13.Verify your settings, and click on Start writing to Database.
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The package is imported into the database. The process may take several stages
to complete, as cer tain information needs to be imported before other related in-
formation.

A message is displayed informing you of whether the import was successful or
not.

14.If you have imported a package containing the data model into Aurea.CRM web,
you need to recycle the application pool, see Recycling the Application Pool
(Aurea.CRM web) on page 70 .

You can cancel the ongoing import process by clicking on Cancel. If you cancel the
import process, those items that have already been written to the database are not
removed.

Note: Triggers and workflows are disabled when importing data in
CRM.cockpit.Changes made to the database during the import process are logged
in the Process Tracking (T3) info area. This locks the CRM.cockpit import and data
model process and no other imports can be performed on the station and the data
model cannot be edited until the current import has ended (and the process is
unlocked). The process tracking records for CRM.cockpit contain "cockpit Import"
in the Process field. The Text field contains information on the name of the template,
the items that were imported and information concerning the import (par tial successes
etc.). For more details on the Process Tracking info area, see Process Tracking
in the CRM.core Administrator Guide. If an import fails to complete (successfully or
unsuccessfully), the import process continues to be locked. To unlock the process,
uss the repair option, see Troubleshooting on page 18 .

Importing Languages
Learn how to add language.

If the package being imported contains Language/Station (01) records, CRM.cockpit
checks whether these languages have been assigned to the target station. If the
language is not yet assigned to the target station and is a catalog language (the
Catalog Lang. field in the language record is enabled), a corresponding language
record is added on the target station. If the language is not a catalog language
(Catalog Lang. disabled), it is ignored.
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Recycling the Application Pool (Aurea.CRM web)
When importing a package containing the data model, catalogs, CRM processes
and roles into Aurea.CRM web, you also also need to apply any changes to the
CRM.designer database and then recycle the application.

You can choose to update the CRM.designer database when importing a package
by enabling the Update CRM.designer option, see Importing Packages on page 65
. If you did not enable this option, either:

• Log on to Aurea.CRM web as SU and select Administration > CRM.designer
Maintenance. Click on Update Data Model in CRM.designer to upgrade the data
model:

• Use CRM.bulkloader to apply the changes to CRM.designer, see Data Model,
CRM Processes, Roles and Catalogs in the Aurea.CRM web Administrator Guide.

Once the CRM.designer database has been updated, recycle the application pool:

1. Open the Control Panel and switch to Administrative Tools.

2. Open the Internet Information Services.

3. Right-click on the appropriate folder under Application Pools and select Recycle
from the popup menu:

Import Restrictions
Learn about the import restrictions applied.

The following restrictions apply:

• The SU and WWW users' passwords are not imported.

• Packages can only be imported on a station that is set up as the main office (in
the Station info area).

• The Main Office field is ignored when importing stations on the target database
(i.e. the main office is left unchanged by the import).

• The package ID defined in the Settings.xml file (CustomerInstanceID element)
on the source and target stations must match. If no ID was assigned to the package
on the source station, the package can be imported on any station (even if an ID
is defined in the Settings.xml file on the target station).
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• Apart from base packages (see Base Packages on page 31 ), packages can only
be imported into databases of the same version of Aurea.CRM (same vertical and
service pack). Base packages can be imported into any ver tical of the same
service pack.

• Packages can only be imported by the SU.

• The catalog base language number must be identical on both the source and
target stations.

• Only global formats in triggers can be imported. Ensure that all such formats are
global, not private.

• Private automatic selection and project selection formats are always added for
the user that imports the package (SU), not the original user.

• The predecessor activity referenced by its follow-up activities is not automatically
added to the packages although the reference is imported; an incorrect activity
record may be referenced as a result.

• In order to import sample records (OTC), you need to define two processes. The
first process you define should contain the sample codes (MK) and additional rep
info (AZ) relating to the sample record. The sample record (MU) itself should be
added to a second process, which must be defined after the first process.

• The "UPDATE_DEFAULT" configuration must be present in the designer database.
This configuration is never included in packages.

• The station numbers of the source and target stations must be different in order
for the data model to be imported and merged. The data model is merged in the
same manner as data models are merged in Aurea.CRM win. For more details on
merging data models, >> Merging Data Models in the CRM.core Administrator
Guide.

• If the source station is assigned a base station number (10,000 and 10,010-10014),
only packages exported on a base station can be imported.

• The values in the External Key, Lock and Sort Order fields of imported catalog
values are not displayed in the details view until the application is restar ted.

Special Upgrade Logic for Non-template Stations
Learn about the info areas that are updated when importing package generated on
a template station to a non-template station.

When importing a package generated on a template station (station number >=10,00)
on a non-template station (station number <10,000) that already contains the
package, records in the following info areas are only updated if they meet specific
criteria:

• MC (Configuration)

• Z6 (Variable Value)

• M1 (Tenant)

71AUREA CONFIDENTIAL

Importing and Exporting Packages



• AS (Station)

• R2 (Login Role)

• A000 (Template Configuration Table)

• A001 (Configuration Translation)

Records that have been updated in these info areas on a non-template station (i.e.
the entry in the Updated on Station field (4203) is < 10,000 and Updated in Module
(4205) is not "cockpit") are not updated when importing. The affected records are
written to the log file and can be viewed in the import history, see Import/Export
History on page 82.

Variable values (Z6) are compared to existing variable values when upgrading. If
the target database already contains a variable value with identical settings, the Z6
record is not imported (status Ignore) again.

Note:  Records where the Update on Station field is empty are overwritten by the
import process.

Canceling an Import
Learn how to cancel an import.

Click on Cancel to stop the import process. Those items that have already been
imported are retained in the target database; if necessary, you need to remove them
manually.

Updating Packages
Learn how to upgrade an existing package.

To upgrade an existing package, import an upgrade package (i.e. one exported using
the Upgrade option, see Exporting Packages on page 60 ) into the target database,
see Importing Packages on page 65 . The system checks that the target database
contains a package with the same name and with the same or a higher version
number than the version used as the basis for generating the upgrade package on
the source station (i.e. the version selected in the Upgrade for cockpit package
drop-down list when exporting). If no previous version of the template is present,
the import is terminated.

If different versions of an item are present in the package and in the target database,
you need to determine which version of the item to retain before items can be im-
ported, see Match-up on page 73.

Note:  If items have been edited in the target database since the last import, but
have not been edited in the source database, these items are not overwritten by
the import process and are not listed when matching up records.
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The following limitation applies to packages that are imported when upgrading a
package:

• Reps are matched up by login, see Match-up on page 73 . If no matching login is
found, the rep is added as a new record.

Match-up
Learn how to match-up versions of package.

When importing a package into a database that contains an earlier version of the
package, you can determine whether to keep the items in the package or in the
database if items have been edited in the meantime. You can skip this step (in which
case items in the package automatically overwrite items in the database) using the
Hide "Matchup" and "Summary" dialog during import option, see Options on
page 98 .

Note: You cannot match up designer units or catalogs.

When importing an updated version of a package into a database that already con-
tains an earlier version of the package, CRM.cockpit compares the versions of indi-
vidual items in the .zip file and in the target database. If any items are different,
these items are listed in the following dialog box:

The name of the item is displayed in the Item column.

Click on Detailed View in either the In Import Item or In Database Item columns
to view the item in either the .zip file or the database.

Click on the XML Diff button in the Xml Difference column to display the difference
in the XML code between the two items.

The By Matchup check box is enabled if the edited record was found using the
hard-coded match-up logic. The algorithm used is the same as when importing using
the Import module. You cannot change this setting.
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Determine which version of the item you wish to store in the target database in the
Matchup column:

• < Database remains unchanged: The version of the item in the database is
retained, as are any dependent items.

• Package overwrites Database >: The version of the item in the .zip file overwrites
the version stored in the database.

• Not defined: No decision has been made which version of the item to retain.

Once you have made your settings, click on Next to continue with the import process.

Deploying Offline Files
You can deploy Aurea.CRM web offline files in a package to Aurea.CRM web's
global patch directory.

When deploying offline files, no other items in the package are imported and only
files containing the '$WEB' parameter are copied to the target directory, see Adding
Files to a Package on page 45 . This directory referenced by the '$WEB' placeholder
needs to be specified when importing using the GUI (it cannot be left empty) or in
the import XML configuration file when deploying files from the command line, see
Command Line on page 74 and Import Settings on page 79.

To deploy Aurea.CRM web offline files:

1. Select File > Import Package from .zip File from the menu and choose a package
containing Aurea.CRM web offline files. The package must have been created
using the This package contains web offline files option, see Exporting Packages
on page 60 .

2. Enable the Deploy web offline files option. All other import options are disabled.

3. Click on Next.

4. Specify the directory for the '$WEB' placeholder. You cannot leave this placeholder
empty.

5. Click on Next.

6. A summary is displayed. Verify your settings and click on Start writing to
Database.

7. The offline files are deployed and a summary is displayed.

Command Line
You can import and export packages from the command line using update.cock-
pit.commandLine.exe, located in the CRM.cockpit root directory.

The import and export settings (e.g. which processes and items) are defined in XML
files. The included ExportConfigExample.xml and ImportConfigExample.xml files
provide a basic package that you can extend as necessary.
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The following parameters are supported:

--help (-?)

Outputs a list of supported arguments and a short description of each.

--import (-i)

Imports the package referenced by the specified XML file. You need to specify the
XML configuration file containing the import settings using the --configuration
parameter.

--export (-e)

Exports the package referenced by the specified XML file. You need to specify the
XML configuration file containing the export settings using the --configuration
parameter.

--configuration

Specifies the path and name of the configuration XML file (both relative and absolute
paths are supported).

Example: update.cockpit.commandLine.exe --export --configuration MyEx-
port.xml

--user (-u)

Specifies the user name used to log in to CRM.cockpit, e.g. "--user su". You do not
need to specify the user when using single sign-in.

--password (-p)

Specifies the password of the user used to log in to CRM.cockpit, e.g. "--password
MyPassword". You do not need to specify the user when using single sign-in. Omit
this parameter if the specified user does not have a password.

--language (-l)

Specifies the language ID that cockpit should be star ted with. For a list of language
IDs, >> Language IDs in the Appendix of the CRM.core Administrator Guide.

--exportDirectory (optional)

Specifies the target export directory (the default is \Export).

--importDirectory (optional)

Specifies the directory containing the zip file to be imported (the default is \Import).

--exportFileName (optional)

The name of the exported package file. Can be used in conjunction with --export-
Directory to specify the target path.
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--importFileName

The name of the file containing the package to import. Can be used in conjunction
with --importDirectory to specify the source path.

--deltabaseversion (-d)

Specifies the version number to use as the basis for an upgrade export, e.g. "-d
8.0.2.12" to export all items added or updated since the specified version number.
The version takes precedence over the version specified in the XML file used by
the export (DeltaBaseMode element, see Export Settings on page 77).

--templatenumber (-t)

Specifies the package version (the third digit in the version number) to be assigned
to the exported package. If this parameter is not specified, the current cockpit
package version number is used.

--exportnumber (-n)

The export number (the four th digit in the version number) to be assigned to the
exported package. If no number is specified, the current package number is incre-
mented by 1 and that value is used.

--initial

When exporting a package, determine whether the initial package flag is set. This
corresponds to enabling the This is an initial package option (see Exporting
Packages on page 60 ), and takes precedence over the entry in the configuration
XML file.

--deployOfflineFiles

Include this parameter to deploy the offline files (those containing the '$WEB'
placeholder) in the package to Aurea.CRM web offline's global patch directory. This
option only applies when importing packages on the target station, see Deploying
Offline Files on page 74 .

Note:  If items in the package are unavailable when exporting the package, no .zip
file is generated. The log file contains information on which items could not be found.

XML File Settings
Learn about the XML file settings.

When using the command line, the import or export settings are defined in an XML
file which needs to be specified in the command line using the --configuration
parameter, see Command Line on page 74 . This XML file determines which items
should be imported/exported, which paths should be used by placeholders etc.

The import and export files contain different XML nodes; you need to define a sep-
arate file for both the import and export of a package.
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Note:  A package cannot be imported while a user is accessing the data model on
the target system. A message is displayed if this is the case. During the import
process, the data model on the target system is locked for editing and is only
unlocked once the import is complete.

Export Settings
Learn about export settings.

The ExportConfigExample.xml file located in the CRM.cockpit root directory provides
you with a simple template XML file for exporting packages. You can create a copy
of this file and adapt it to meet your needs.

The export XML file supports the following nodes:

TemplateName

Specifies the name of the package to be exported.

ExportType

Determines the type of export: Full or Upgrade. The default value is Full. When set
to Upgrade, the DeltaExportMode elements must also be defined.

ItemsToExport

The elements in this node define which items should be exported:

• ItemsToExport\CatalogMaintenanceItems

Determines whether catalog maintenance records should be exported. The default
value is false.

• ItemsToExport\TextTableItems

Determines whether the contents of the Text info area should be exported. The
default value is true.

• ItemsToExport\CoreItems

Determines whether core items should be exported. The default value is true.

• ItemsToExport\FieldHelp

Determines whether the field help should be exported. In addition to all field help
records (FH), all texts in the text table (04) are also exported that are referenced
by the field help (even if ItemsToExport\TextTableItems is false). The default
value is false.

• ItemsToExport\DesignerUnits

Determines whether designer units should be exported. The default value is true.

• ItemsToExport\Files

Determines whether files should be exported. The default value is true.

• ItemsToExport\Processes
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All processes are exported by default. To restrict the processes that are exported,
add a Process element for each process you with to export containing the name
of the process.

Description

Specifies the description of the exported package.

CatalogMaintenance\StationNumber

The name of the target station on which the data is later imported. This value is
empty by default. This field is purely for documentation purposes and has no other
function.

CatalogMaintenance\CatalogMaintenanceID

Specifies the ID of the first catalog maintenance record to export. The catalog
maintenance record with the specified ID and all subsequent catalog maintenance
records (i.e. those with higher IDs) are exported.

CatalogExportOptions

These options determine which catalogs are exported and for which tenants:

• CatalogExportOptions\FilterMode

Determines which catalogs are exported:

• ExportAll: Exports catalog values irrespective of the tenant assigned to the
catalog value (default)

• CatalogsWithoutTenant: Exports only those catalog values where no tenant
is assigned (tenant-independent values)

• WithConditionsOnTenant: Exports catalog values for those tenants specified
in the TenantNumber elements.

• CatalogExportOptions\Tenants

Add a TenantNumber element containing the tenant number for each tenant number
whose catalogs you want to include in the export. Enter 0 (zero) for catalog values
without a tenant.

Note:  CRM.cockpit does not check whether these tenants are present in the
database or not.

• CatalogExportOptions\SelectedCatalogs

To export all catalog values for a specific catalog (instead of only the values
assigned to the tenants specified in the TenantNumber elements), add a CatalogNum-
ber element containing the catalog number for each catalog you want to export
in full. The other CatalogExportOptions settings are then ignored for this catalog.
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DeltaExportMode

The elements in this node affect exports used to upgrade a package. These elements
are mandatory for upgrades. The following elements are available:

• DeltaExportMode\SelectionMode

Specifies the export version used to determine which items are exported, i.e. the
items that have been added or changed since the specified export. The following
values are permitted:

• LastExport: Exports the changes since the last export. This is the default
value.

• SpecificVersion: Specify the version number in the DeltaBaseVersion element.
All items added or updated since this version are included in the package.

• DeltaExportMode\DeltaBaseVersion

Specifies the base version used by the upgrade export when SelectionMode is
set to SpecificVersion, e.g. "8.0.2.12".

PackageContainsWebOfflineFiles

Determines the status (true/false)of the flag that stores whether the package
contains Aurea.CRM web offline files. These files (containing the '$WEB' placeholder)
are copied to Aurea.CRM web offline's global patch directory if the DeployWebOf-
flineFiles parameter is set to true in the import XML configuration file, see Import
Settings on page 79 .

Import Settings
Learn about the import XML files in CRM.cockpit.

The ImportConfigExample.xml file located in the CRM.cockpit root directory provides
you with a simple template XML file for importing packages. You can create a copy
of this file and adapt it to meet your needs.

The import XML file supports the following nodes:

DeployWebOfflineFiles

If set to true, web offline files (files containing the '$WEB' placeholder) are copied
to Aurea.CRM web offline's global patch directory. This setting only applies if the
package is flagged as containing web offline files (Contains web offline files option
or PackageContainsWebOfflineFiles parameter in the export XML configuration file,
>> Deploying Offline Files on page 74 .

Note:  Ensure that you have defined the path for the '$WEB' placeholder under
FilePaths (see below).
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ItemsToImport

The elements in this node define which items should be exported (similar to the
ItemstoExport node in the export configuration XML file, see Export Settings on
page 77 ):

• ItemsToImport\CoreItems

Determines whether core items should be imported. The default value is true.

• ItemsToImport\CatalogMaintenanceItems

Determines whether catalog maintenance records should be imported. The default
value is false.

• ItemsToImport\TextTableItems

Determines whether the contents of the Text info area should be imported. The
default value is true.

• ItemsToImport\DesignerUnits

Determines whether designer units should be imported. The default value is true.

• ItemsToImport\FieldHelp

Determines whether the field help is imported. If field help is imported, all text
table entries referenced by the field help are also imported, even if ItemsToIm-
port\TextTableItems is set to false. The default value is false.

• ItemsToImport\Files

Determines whether files should be imported. The paths to be used by placeholders
are defined in the FilePaths element. The default value is true.

FilePaths\Item

Each Item node contains a Key attribute, which corresponds to a placeholder used
in file paths (e.g. "$WEB"). Define the associated file path for the placeholder in
the Path element (e.g. "C:\web\").

UpdateCrmDesigner

These settings determine how catalogs in the CRM.designer database are updated
by the import:

• UpdateCrmDesigner\UpdateCatalogs
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Determines which catalog values are updated in the CRM.designer database. The
following options are available:

• NewOrChanged: Any catalogs values that are added or updated by the import
process are synchronized with CRM.designer (default).

• Existing: Only existing catalog values are updated by the import process and
synchronized with CRM.designer. Determine how catalog values are matched
up using the CatalogSyncMode element.

• None: No catalogs are updated in the CRM.designer database.

• UpdateCrmDesigner\CatalogSyncMode

Determines how existing catalog values (Existing option in the UpdateCatalogs
element) are matched up with catalog values in the package:

• Text: Catalog values in the package are matched up with catalog values in the
target CRM.designer database by the value in the catalog base language and
tenant number (default).

• ExternalKey: Catalog values in the package are matched up with catalog values
in the target CRM.designer database using the catalog value's external key.

Return Codes
Learn about CRM.cockpit Commandline return codes.

CRM.cockpit includes a command line application from update.seven Service Pack
8 onwards. The command line application can be used to import and export packages
using batch or PowerShell scripts.

The return codes inform the calling application about the status of the import or
export of cockpit packages.

81AUREA CONFIDENTIAL

Importing and Exporting Packages



Support-
ed in

Version

MeaningReturn
Code

8.0No errors0

8.0Error parsing command line parameters1

8.0Error parsing XML configuration file2

8.0Import/export error3

8.0Help information displayed4

8.0Import Cancelled5

8.0Refresh All failed: one or more item was unavailable and export
was canceled.

6

8.2The import was canceled because a package without catalog
service records has already been imported into the target
database.

7

8.2The import was canceled because the target station is a base
station but the package was created on non-base station.

8

8.2The import was canceled because the customer instance ID in
the import package does not match the customer instance ID on
the target station.

9

8.2The import was canceled because web offline files could not be
deployed.

10

8.2The import was cancelled because a lock could not be acquired.11

V8.2 Fea-
ture Pack

The export was canceled because the datamodel was edited after
the current cockpit session star ted.

12

8.0An exception occurred during the import or export.100

Import/Export History
Click on Imports/Exports in the icon bar to display a list of imports and exports
you have carried out, sor ted in chronological order.

Click on All Imports/Exports in the icon bar to display a list of all imports and ex-
ports you have carried out for all packages in the database. The entries are grouped
by package.

Click on an entry in the list to display fur ther information, including the star t and
end time of the export/import, its description (exports only) and other settings and
version information.
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Only a limited number of logs are stored within a package in order to reduce storage
requirements. By default, the last 3 import logs and last 50 export logs are stored
in a package, but you can change these values, see Configuring the Number of Logs
Stored in the Template on page 86 .

Logs are also written to individual external log files for each import/export. Click on
the link to the external log file next to Import/Export log file to open the CSV log
file in the associated application, see Import Log File on page 84 and Export Log
File on page 86 . As a large number of log files may be created over time, it makes
sense to periodically delete older log files.

Note: The system does not check whether the linked log file actually exists.

Export logs

Click on Change Persistence in the Export header to toggle the Save this export
for future upgrades flag (the current status is displayed towards the end of the
Export section). This option can also be set when exporting the package, >> Export-
ing Packages on page 60 .

The export logs includes the following information:

• The type of export ("Full" or "Upgrade")

• Date and time of the export

• Language

• Source station number

• Catalog base language

• Aurea.CRM vertical code

• Number of Text table records

• List of the exported processes

• Number of text table and field help records exported

• ID of the last catalog service record. The external ID of this record is displayed
in brackets.

• A link to the log file (CSV) containing an overview of the items that were exported,
see Export Log File on page 86 .

• An overview of the export options (Items to Export)

• CRM.cockpit version

• Package version number

• Catalog maintenance information (target station, IDs etc.)

• An overview of the number of records exported per group and sub-group , see
Adding Multiple Records Based on Conditions (Groups) on page 43 .
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Import Logs

You can display information in CRM.cockpit on all the items that were imported, in-
cluding their state following the completion of the import process (e.g. update,
failed):

1. Use the check boxes under Display in the Filter section to determine the state
of items to be displayed.

2. Select the type of items to restrict the details to from the Item Type drop-down
list. Select "All" to display all types of items.

3. Click on Apply Filter to list those items whose status corresponds to your selection
under Details.

The corresponding items are displayed, including the status of the item.

4. Click on the downward arrow next to an item to display an XML overview of the
item.

The following information is displayed in the import logs:

• The star t and end time of the import

• The number of text table and field help records imported, as well as the number
of text table records related to the field help

• The first and last catalog maintenance IDs that were imported. The IDs on the
source system are displayed in brackets followed by the IDs on the target system.

• If no catalog maintenance items were imported, "Catalog maintenance record
with ID X created" is displayed, where X is the last catalog maintenance ID on
the source system. When importing the package in future (upgrade packages),
only catalog maintenance records with a higher ID are exported.

Import Log File
Learn how to use read import log file for troubleshooting.

In order to simplify the troubleshooting of import problems, an import log containing
information on which items were imported and in what order is created. The location
of the log file is configured in the writer filePath element (under ImportLogging)
in the Settings.xml file (default is .\log\update.cockpit.import.csv). Aside from
the default log file, which is overwritten with each import, the log file is also saved
under a unique name by appending a unique ID to the file name (e.g. update.cock-
pit.import_1836a97d-f833-4f00-a296-fda6301471c4.csv).

You can open the log file from the overview of an import, see Import/Export History
on page 82.

Note:  As a large number of log files may be created over time, it makes sense to
periodically delete older log files.
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The log file is split according to the import phases (as displayed in the import win-
dow). The log file includes the star t and end of the import process and the individual
phases, as well as the following information on individual items (separated by
semicolons):

• Import time stamp (e.g. 2009.07.13;16:57:48)

• Log entry type (e.g. Import, Info)

• The type of item (e.g. Record, Format)

• The item's URI (e.g mm://Record/00/x0000000000000001)

• The status of the import (e.g Success), see below

• The type of import (e.g. New, Update, Deleted, Converted)

• XML overview of the data, which includes additional information such as the record
ID and key. The information in this column is a representation of the XML data
available for items in the import logs in CRM.cockpit's import history, see Import/Ex-
port History on page 82.

The import status can have the following values:

• None: No import necessary (e.g. core data model)

• Success: The item was imported successfully

• PartialSuccess: The item was imported, but is incomplete (e.g. not all catalog
entries have been imported or links are missing)

• Failure: The item was not imported successfully

• Converted: The item's base ID/field number was converted to the ver tical-specific
ID/field number

• Deleted: The format was deleted in the target database

• Update Denied: A existing record was not updated by the import as it has been
edited on the target station. This only applies to records in cer tain info areas, see
Special Upgrade Logic for Non-template Stations on page 71 .

Records that have been updated in these info areas on a non-template station (i.e.
the entry in the Updated on Station field (4203) is < 10,000 and Updated in Module
(4205) is not "cockpit") are not updated when importing. The affected records are
written to the log file and can be viewed in the import history, see Import/Export
History on page 82.

The import type can have the following values:

• New: The item was added to the database

• Updated: The existing item in the target database was updated with the item in
the package

• Ignore: The item existed in the target database and you chose not to overwrite
it, or the item was only changed in the target database and not in the source since
the last import.
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Export Log File
In order to simplify the troubleshooting of import problems, an export log containing
information on which items were imported and in what order is created.

The location of the log file is configured in the writer filePath element (under Ex-
portLogging) in the Settings.xml file (default is .\log\update.cockpit.export.csv).
Aside from the default log file, which is overwritten with each import, the log file is
also saved under a unique name by appending a unique ID to the file name (e.g.
update.cockpit.export_1836a97d-f833-4f00-a296-fda6301471c4.csv).

For more details on the formating and settings, see https://support.aurea.com.

You can open the log file from the overview of an export, see Import/Export History
on page 82.

Note:  As a large number of log files may be created over time, it makes sense to
periodically delete older log files.

The log file includes the star t and end of the export process, as well as the following
information on individual items (separated by semicolons):

• Export time stamp (e.g. 2009.07.13;16:57:48)

• Log entry type (e.g. Export, Info)

• The type of item (e.g. Record, Format)

• The item's URI (e.g mm://Record/00/x0000000000000001)

• The status of the export (e.g Success), see below

The export status can have the following values:

• Success: The item was exported successfully

• Failure: The item was not exported successfully.

Configuring the Number of Logs Stored in the Template
You can determine the number of import and export logs to be stored in the package.

Storing a large number of logs in the package increases the size of the package
format, which impacts on performance.

Configure the number of logs to store in the package in the Settings.xml file (Num-
berOfImportLogs (for import logs) and NumberOfExportLogs (for export logs) ele-
ments).

By default, 3 import logs and 50 export logs are configured. If the corresponding
entries are missing in the Settings.xml file, the last 5 import and last 20 export
logs are stored in the package. If you enter a value of zero, only the most recent
log is stored in the package.
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Example: The Life Cycle of a Package
Learn about the life cycle of a package.

The following section demonstrates the various steps necessary to create a package,
including importing and exporting the package and generating associated documen-
tation.

Note:  update recommends that you develop and test your packages outside your
production environment! It also makes sense to create a second (test) database
that is used to import and test your package.

The life cycle of a package goes through the following stages:

1. Defining the configuration items in Aurea.CRM.

2. Defining the package, including all processes and items, see Step 1: Defining the
Package on page 87.

3. Exporting the package for use in another database, see Step 2: Exporting the
Package on page 92.

4. Importing the exported .zip file in the target database, see Step 3: Importing the
Package on page 93.

5. Generating documentation, see Step 5: Generating Documentation on page 95.

6. Maintenance of the package, including changes to the package or items included
in the package, see Step 4: Updating the Package on page 94

For information on configuring items in Aurea.CRM, refer to the corresponding
manuals.

In general, defining your package is a less linear process than described here.
Configuring Aurea.CRM generally involves testing the various configuration items,
and you often add fur ther configuration items to the database after creating the initial
package. Configuring Aurea.CRM and defining the package therefore often take
place concurrently. Use the synchronize function to add newly defined configuration
items to your package and to remove items that have subsequently been deleted
from the database.

However, for the purpose of this example, we shall treat configuring the application
and defining the package as separate steps.

Step 1: Defining the Package
The first step is to define the package in CRM.cockpit.

Below are the steps to define a package:
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Step 1.1 Configuring Items in Aurea.CRM

The various items that are added to the package, such as formats, the data model,
documents etc. all need to be defined within the Aurea.CRM application itself. You
should be comfortable with the various customization options provided by Aurea.CRM
before defining your own packages. For more details on the various configuration
options, see the corresponding manuals.

You should define the following, which are used in this example:

• A rights format including a trigger.

• Your own company as a record in the Company info area.

• A new info area in the data model (e.g. Customer Complaints).

• An XSLT file, e.g. for reports.

• A designer unit, such as an analysis, for use with Aurea.CRM web.

Step 1.2 Creating a Blank Package

1. Select File > New from the menu to create a new blank package.

2. Click on Description in the icon bar.

3. Click on  next to the Description and enter a description of the package (e.g.
"Training Package").

4. Enter a Title, Subtitle, Author.

Step 1.3 Adding a Process to the Package

1. Click on Processes in the icon bar.

2. Click on New in the header.

3. Enter a name for the process (e.g. "Basic setup").

4. The name of the process is displayed as a hyperlink on the Processes page.
Click on the name to switch to the process.

5. Enter a description for the process (e.g. "Basic setup including rights settings").

Step 1.4 Adding an Info Area

The Aurea.CRM database includes a new info area (e.g. "Customer Complaints"),
defined using the data model. If you have not already done so, add an info area to
the data model.

Note that adding a single item from the data model (e.g. an info area) automatically
includes the entire data model in the process.

To add the info area to your package:

1. Switch to the process you defined earlier.

2. Click on  next to Referenced Items and select Info Area from the list.

A list of the info areas in the Aurea.CRM database is displayed.

3. Click on the name of the Customer Complaints info area in the list.
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4. The display returns to the overview of the process and the Customer Complaints
info area is listed under Referenced Items. The data model is now included in
the package, and importing the package into a Aurea.CRM database adds the
data model to the target database.

5. Click on the link to the info area and enter a description (e.g. "Used to process
customer complaints").

6. If you wish, you can enter descriptions for individual fields in the info area. To do
so, switch to the overview of the info area, click on the corresponding field under
Referenced Items and enter a description of the field.

Step 1.5 Adding a Format

Formats in Aurea.CRM are used to store a wide range of configuration options,
ranging from desktop settings to transfer fields. Formats can contain references to
other formats; for example rights formats can reference a range of other formats,
such as triggers and workflows.

Formats within formats are a special case. In our example, we are going to include
a rights format which includes references to another format. Because formats includ-
ed in other formats are included as a reference, you can make changes to the indi-
vidual formats, without needing to edit the parent format.

1. Define a rights format that includes a trigger.

2. Switch to the process you added earlier.

3. Click on  next to Referenced Items and select Format from the list.

A list of the format types in the Aurea.CRM database is displayed.

4. Click on "Rights" under Format Types. Click on the desired rights format.

The display returns to the overview of the process and the rights format is listed
under Referenced Items.The rights format is now included in the package and
importing the package into a Aurea.CRM database adds the rights format to that
database.

The trigger format referenced by the rights format is also added to the process.
Any fields that have been added to a condition that determine when the trigger
is star ted are also added.

5. Click on the link to the rights format. You notice that the trigger format has also
been added. Add an appropriate description for the rights format (e.g. "Basic
access rights settings").

6. Click on the link to the trigger format (under Referenced Items in the rights
format) and enter an appropriate description as well.

Step 1.6 Adding Catalogs

Catalogs are maintained in the Maintenance module. Furthermore, you can add
custom catalog fields to info areas using the data model.

The Customer Complaints info area in our package (see Step 1.4 Adding an Info
Area ) makes use of the Product and Product Group catalogs and we are going
to include these catalogs in our package.

1. Switch to the process you added earlier.

2. Click on  next to Referenced Items and select Variable Catalog from the list.
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A list of the variable catalog in the Aurea.CRM database is displayed.

3. Click on P above the list to limit the display to catalogs whose name begins with
'P'.

4. Enable the check boxes next to Product and Product Group and click on Add
Selected Items in the header to add the two catalogs.

The display returns to the overview of the process and the catalogs are listed
under Referenced Items. The catalogs are now included in the package and im-
porting the package into a Aurea.CRM database adds the catalogs values to that
database.

If you have defined catalog entries in multiple languages, you need to manually
add the appropriate Language Table records (00) and Station Language records
(01).

Step 1.7 Adding a File

Files in processes are generally configuration files, for example XSLT stylesheets
for reports or JavaScript items used by Aurea.CRM web. These files need to be
placed in specific directories; e.g. reports stylesheets need to be placed in the
\system\xml directory of your Aurea.CRM installation.

1. Create an XSLT stylesheet for use in Aurea.CRM win.

2. Return to CRM.cockpit.

3. Switch to the process you added earlier.

4. Click on  next to Referenced Items and select File from the list.

5. You can determine whether the document is stored in the Aurea.CRM database,
or whether the file is referenced by the package using the file name and path.

Select documents into Aurea.CRM database to determine that the file should
be stored in the Documents info area on the source machine. Documents that
are stored in the database on the development system are also written to the
Documents info area on the target system when imported.

6. Enter "$WIN\system\xml\" as the Destination directory for your XSLT. '$WIN'
functions as a placeholder. When the package is imported on the target machine,
you are prompted to specify the directory to be used by the placeholder.
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Although you can use any placeholders (indicated with a preceding '$'), update
recommends using $WIN for Aurea.CRM win installations and $WEB for
CRM.designer installations.

7. Click on the  next to Files and select the XLST you created.

8. The source and target files are displayed. You can add fur ther files in the same
manner.

9. Click on Add Selected Items in the header to add the files to the process.

10.The display returns to the overview of the process and the file is listed under
Referenced Items.The file is now included in the package and importing the
package into a Aurea.CRM database prompts the user to determine the directory
that the $WIN placeholder refers to (in this case, the root directory of the
Aurea.CRM installation). The file is then copied to the corresponding directory.

Step 1.8 Adding a designer Configuration

Note:  Adding a designer unit automatically adds the designer configuration
containing the unit to the process, as well as any parent configuration apart from
those supplied by update (e.g. UPDATE_DEFAULT).

To add a designer configuration to your package:

1. Switch to the process you defined earlier.

2. Click on  next to Referenced Items and select designer Configuration from
the list.

3. A list of the designer configurations in the designer database is displayed.

4. Enable the check boxes next to the desired configuration and click on Add
Selected Items to add the configuration to the process.

The display returns to the overview of the process and the selected designer
configuration is listed under Referenced Items.The designer configuration is now
included in the package and importing the package into a Aurea.CRM database
adds the designer configuration to the target database.

5. Click on the link to the designer configuration and enter a description.

Step 1.9 Adding a Record

You can add most types of records to your packages. In our example we are going
to include our own company in the package.

1. If you have not already done so, add your company to the Company info area in
Aurea.CRM.

2. Switch to the process you defined earlier.

3. Click on  next to Referenced Items and select Record from the list.

A list of the info areas in the Aurea.CRM database is displayed under Info Areas.

4. Click on "Company". A list of the companies in the database is displayed.

5. Click on the entry that corresponds to your company.
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The display returns to the overview of the process and the record is listed under
Referenced Items. The type of record (info area abbreviation) and its key are
also included.The record is now included in the package and importing the package
into a Aurea.CRM database adds the record to that database.

6. Click on the link to the record and enter a description (e.g. "Our company").

Step 2: Exporting the Package
The second step is to export the package.

In order to import the configuration items added to the package on the target ma-
chine, the package needs to be exported as a .zip file.

1. Select File > Export Package as .zip File from the menu.

2. Choose where to save the .zip file and enter a name. The name of the package
followed by the current date and time is suggested by default.

3. A dialog box is displayed. Set the export type to Full and choose to export all
items using the check boxes.

4. A dialog box is displayed. You can determine which processes to include in the
.zip file.

Make sure to include the process you defined.

5. Choose Full as the Export Type to export the entire package. Enable all the
Items to Export to export all the items in the package.

6. Enable This is an initial package, as this is the first export.

7. Enable Save this export for future upgrades to add the export to the list of
exports. You can then select this export (from the Upgrade for cockpit Package
drop-down list) when next exporting the template in order to only export the
updated items the next time in order to upgrade the target system, see Step 4:
Updating the Package on page 94.

8. Click on Next.

9. Choose to export the process you defined (leave the check box enabled). Click
on Next.

10.Click on Next. Check that Export all catalog values is enabled.

11.Click on Next. An overview of your settings is displayed. Verify that you have
included the process.

12.Click on Start Export.

The package is exported. You can choose to view an overview of the status of
the items in the package once the export is complete.
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Step 3: Importing the Package
The package exported in Step 2 then needs to be imported on the target machine.

CRM.cockpit needs to be installed on the target system, and packages can only be
imported on the station designated as the main office (in the Stations info area).
Ensure that the database on the target machine is empty. The SU and WWW users
need also to be present in the database on the target machine.

1. Copy the .zip file exported in Step 2 to the target machine.

2. Start CRM.cockpit on the target machine and log in as SU.

Note:  Only the SU can import a package.

3. Because the database on the target system does not contain a package (template
format), you are asked if you wish to import an existing .zip file or create a new
package. Choose to import a .zip file.

4. Select the .zip file you exported in Step 2 and click on Open.

5. Confirm that you wish to import the package. A dialog box is displayed.

You can determine which of the items included in the package are imported. You
can choose whether to import core items (Aurea.CRM win items, such as formats,
info areas etc.), designer units (for designer databases) and the attached files.

6. Choose to import all types of items in the package and enable the Update
CRM.designer option to update the data model and catalogs in the CRM.designer
database.

7. You is then prompted to determine the directory used by the placeholder in the
path of the .xml file. Click on ... in the Select Destination Folder column and
select the root directory of your Aurea.CRM win installation on the target machine.

8. Click on Next. A summary of your settings is displayed.

9. Verify your settings, and click on Start writing to Database.

The package is imported into the database.

10.Once the package has been imported, the Process page is displayed. Verify that
you have imported the correct processes and data.
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Step 4: Updating the Package
You can update packages in CRM.cockpit and import the updated package to upgrade
an earlier package.

Update the package on the development system and import the upgrade package
into the database on the production system. Updates should be exported using the
Upgrade option to only include the changes made to the package since the last
export (selected in the Upgrade for cockpit Package drop-down list), see Exporting
Packages on page 60 . This reduces the size of the import file and speeds up the
import process.

When exporting the upgrade, catalog maintenance items should be exported to up-
date the catalogs on the target station with any changes made on the source station,
see Catalog Management on page 95 .

However, there are a number of restrictions that when updating packages, see Im-
porting Packages on page 65 .

Editing Items and Synchronizing the Package

1. Edit the rights format you included in the package on the development system (in
the Rights module in Aurea.CRM).

2. Save the edited rights format under the same name.

3. Add a second access rights format for different users (and under a different name).

4. Switch to CRM.cockpit and synchronize the package with the database by selecting
Edit > Wizard: Sync Package Items with Aurea.CRM Database from the menu.

A list of the items changed in the development database since the last synchro-
nization are displayed. The rights format is included in the list.

5. Click on the newly defined rights format and drag it to the process icon on the
right. The cursor changes to a plus:

Updating the Production System

The changes made to the package now need to be applied to the database on the
production system.

1. Export the package from the development system using the Upgrade export type
and select the previous export in the Upgrade for cockpit Package field. Enable
Catalog Maintenance Items under Items to Export to update the catalogs on
the target system with any changes made on the source system.

2. Copy the .zip file to the production system.

3. Start CRM.cockpit on the production system.

4. Select File > Import Package from .zip File from the menu.
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5. Select the processes and items to import.

6. Because different versions of your initial rights format exist in both the .zip file
and the target database, you need to determine which of the versions to keep in
the database, see Match-up on page 73 . The following dialog box is displayed:

7. Select Package overwrites Database > in the Matchup column to determine that
the rights format stored in the .zip file should replace the rights format in the
database.

8. Click on Next . A summary is displayed.

9. Click on Start writing to Database.

Step 5: Generating Documentation
You can generate documentation at any time to document the current status of the
package.

To create the documentation:

1. Select File > Create Documentation from the menu.

2. Choose where to save the file and enter a name. Confirm with OK.

3. The RTF document is generated and opened in the associated application.

Catalog Management
Learn how to manage catalog.

Catalogs values in Aurea.CRM are uniquely identified by the catalog value in the
catalog base language and the tenant number. This unique key is used to match
up catalog entries when importing catalog values. The catalog base language is
defined in the Language info area in the Rights module. Only one language may
be defined as the catalog base language, and the catalog base language must be
the same on all stations in a distributed setup. CRM.cockpit checks that the catalog
base language numbers in the package and target database match when importing
packages.
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Catalogs can only be maintained on a catalog maintenance station, which is defined
in the station records, see Station in the Rights Module topic of the CRM.core Ad-
ministrator Guide. Changes to catalog values are tracked in the Catalog Mainte-
nance table on the catalog maintenance station. Both old and new catalog values
are stored in the table whenever a value is added, changed or deleted. When catalog
maintenance records are imported on other stations, the entries in these records
are used to update catalog values on the target station (updating old catalogs value
to new ones). This catalog maintenance information should be included when export-
ing upgrade packages to allow catalogs on the target station to be updated,
see Exporting Packages on page 60 . For more details on catalog management in
Aurea.CRM, see Automatic Catalog Maintenance in the Aurea.CRM win Administrator
Guide.

If you intend to maintain the catalog values used in your package, configure the
development station and target stations as catalog maintenance stations and always
include the catalog maintenance records when exporting the package once a target
station has been initialized, see Transporting Catalogs using Catalog Maintenance
Records on page 97.

Catalogs themselves can also be added to packages, and catalogs in the package
can be imported on the target station. In this case, catalogs are imported in a similar
manner to other package items and catalog entries are matched up using the unique
key (text in the catalog base language + tenant number).

Note:  Catalogs are not imported if the Include Catalog Maintenance Records
option is enabled when importing.

Catalogs can be referenced by a wide range of formats (e.g. conditions) and records.
When transferring formats using CRM.cockpit, it is therefore important to ensure
that the catalog value referenced by package items is identical in the base language
on the target system.

For more details on the catalog numbers used by variable catalogs in base packages,
see Vertical Independent Configuration on page 32.

Note:  If catalogs are updated (e.g. in the Catalog info area in Aurea.CRM win or
via communication), CRM.cockpit needs to be restar ted in order to reload the updated
catalog values.
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Transporting Catalogs using Catalog Maintenance
Records
Learn to use catalog maintenance records for transporting catalog.

In order to maintain catalog values in your package, update recommends configuring
the source and target stations as catalog maintenance stations. Catalog maintenance
records (KW) in a package can only be imported on a catalog maintenance station.
In general, your source station should also be a catalog maintenance station, al-
though you can export catalog maintenance records from other stations. Catalog
maintenance records are imported and exported using the Include Catalog Mainte-
nance Records option. This option should always be enabled, except for when ini-
tially exporting the package (in this case, a dummy catalog maintenance record is
added on the target station containing the ID of the last catalog maintenance record
in the source database). If you do not use catalog maintenance records to maintain
catalogs, the catalogs in the template always overwrite existing values on the target
station.

When importing a package, CRM.cockpit does not import any catalogs in your
package if the Include Catalog Maintenance Records option is enabled and the
source package contains catalog maintenance records, see Importing Packages on
page 65 . This ensures that only changes made to catalogs on the development
system are applied to the target database; other changes made on the production
system are unaffected.

Note: When exporting from stations with a station number >= 10,000, deleted
catalog values are only included if the tenant number is not empty. Deleted catalog
values with no tenant assigned are ignored and not updated on the target system.

The recommended procedure for managing catalogs is as follows:

1. Configure the source and target stations as catalog maintenance stations, see
Station in the Rights Module in the CRM.core Administrator Guide.

2. Add all necessary catalogs to the package on the development system.

3. Export the package from the development system in an initial export so that the
required catalogs are present in the zip file.

4. Import the package on the target station (leaving Include Catalog Maintenance
Records disabled) to initialize the catalogs on the target station with the catalog
values from the source station, ensuring the two are synchronized.

5. Maintain the package's catalog values on the source station, see Adding New
Catalog Values on page 98 .

6. Enable the Include Catalog Maintenance Records option when exporting
subsequent updates so that the package includes information on changes to
catalog values, see Exporting Packages on page 60 .
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7. Import the updated package on the target system using the Include Catalog
Maintenance Records option to input the catalog maintenance records. Catalog
values on the target station are overwritten by changes from the source station.
Note that existing catalog values that have been changed on the source station
is overwritten, including any values that have been changed on the target station
in the meantime.

8. If the source station is a catalog maintenance station (recommended), and the
external key of the catalog maintenance record is empty, an ID is generated
automatically when inputting catalog maintenance records and written to the Ext.
Key field in the catalog maintenance (KW) record (composed of the source station
number and serial number).The ID uniquely identifies catalog maintenance records
from other catalog maintenance stations and prevents changes to catalogs from
being applied on the same station multiple times.

Note:  If you disable the Include Catalog Maintenance Records option when
importing a package, the catalogs in the package are imported instead of catalog
maintenance records. This updates all values in these catalogs on the target system,
including any values since changed on the target system. Do not mix approaches:
import either catalog values or catalog maintenance records exclusively
(recommended by update) after the initial import. If the target station contains catalog
maintenance records and Include Catalog Maintenance Records is not enabled
when importing, you are prompted whether you want to overwrite the catalogs on
the target system. When importing via the command line, define the behavior in the
IgnoreCatServiceWarning parameter in the import XML file (default is false, i.e.
the catalogs are not overwritten).

Adding New Catalog Values
Learn how to add new catalog values.

New catalog values can be added on both production systems (depending on access
rights) and the development system. Whenever a user adds a new catalog value on
a production system, the user needs to enter the catalog value in the catalog base
language. This ensures that catalog values are always uniquely identified (catalog
value in the base language + tenant number).

If catalog values are edited on the production system, and these changes should
be transferred to the development system, export a package on the production
system containing only the catalog maintenance items, and import this package on
the development system.

Options
Learn how to edit options.

Select Edit > Options from the menu to edit the options.

The following options are available:
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Hide "Check Availability" dialog

Prior to checking the availability of units in the package, a dialog box is displayed,
informing you that the process may take a long while. You can choose to cancel the
process from the dialog box.

If you enable the Hide "Check Availability" dialog option, this dialog box is no
longer displayed.

You can also prevent the dialog box from subsequently being displayed by enabling
the Do not show this question again check box in the dialog box itself. If you do
so, you can determine that the dialog box should be displayed again by disabling
the Hide "Check Availability" dialog option.

Hide “Replace File” dialog

Use this option to suppress the dialog box displayed when importing a package, if
a file in the package is already present. If this option is enabled, files are overwritten
automatically.

Hide "Matchup" and "Summary" dialog during import

Use this option to skip the match-up step when importing a package and to suppress
the Summary dialog. Data in the package being imported automatically overwrites
data in the database if this option is enabled.

Don't display refresh dialog during export if all items are available

Enable this option to determine that the refresh dialog (Current status  of refer-
enced items) should not be displayed when exporting a package if all necessary
items are available in the database. In this case, the dialog is only displayed if
package items are missing in the database.

Note: This setting only affects the export; the dialog is still displayed when checking
the availability of items manually using the Check Unit Availability option.

Do not include all dependencies for package items

This option determines that formats, info areas and catalogs added to the package
are added without including their related items. This is the same as enabling the
Do not include all dependencies option for all items, see Adding Items to a Process
on page 40 . This option is intended for applying updates to existing items in the
package where the dependent items have not been changed. The dependent items
still need to be present on the target system (i.e. from a previous import), otherwise
the import fails.
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4
Documentation
CRM.cockpit allows you to document the package and the various items included
in a package in RTF format.

CRM.cockpit can automatically generate documentation for your package.

The following information is included in the documentation:

• The descriptive contents entered manually for the individual items in the package,
see Description on page 24 . For this reason it is important to ensure that you
document your changes as you make them, to ensure that all documentation is
up to date.

• General information on the items included in the package, such as their name,
history, item references etc.

Creating Documentation
Learn how to create documentation.

To generate documentation for a template:

1. Select File > Create Documentation from the menu.

2. Browse to the target directory and enter a file name for the documentation.

3. Select which topics are to be included in the documentation. The following topics
are available:

• Processes: Outputs a breakdown of the contents of processes in the package
with an overview of all items in the process grouped by type.

• Appendix: Outputs information on the individual items in the package, grouped
by type. The item overview includes the item's name, description, documents,
hyperlinks, and a list of items that reference it.

• Delta: Lists all formats that have been edited in this version (and therefore
have a new version number that is the same as the package version number).

4. Choose whether to include additional information in the appendix if you have
included the appendix in the documentation. The following options are available:

• History: Enable this option to include the history of each item in the appendix.

• Referenced Items: Enable this option to include a list of all items references
by an item in the appendix.
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5. Click on OK.

6. The documentation is generated and opened in the associated application.

Customizing the Images on the Title Page
Learn how to customize images on the title page.

By default, the title page includes a header (1) and gray line (2) as shown below:

Replace CoverSheetHeader.jpg and CoverSheetLine.jpg in the \Resources\Images\
folder of your CRM.cockpit installation to use your own graphics on the title page.

Note:  Make a backup of the original files before overwriting them!

Creating Bug Reports
Learn how to create bug report.

You can create a bug report .zip file that contains information on your system and
your log files for troubleshooting purposes.
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To create a bug report:

1. Select Help > Create Bug Report from the menu.

2. The default file name is BugReport_<date>_<time>. Choose where to save the
bug report and click on Save.

3. Once the file has been created, you can choose to open it.

The .zip file contains the following files:

• About CRM.cockpit.txt: Information on your version of cockpit and Aurea.CRM,
the station number etc. as displayed in the About screen in CRM.cockpit.

• u8_cockpit.log and update.cockpit.log: CRM.cockpit log files located in \Log\.

• All .csv files in \Log\Cockpit, see Import Log File on page 84 and Export Log
File on page 86.
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